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ABSTRACT 

Istabiqul Sa‟adah. 143221089. A Correlation between Extroversion Personality, 

Vocabulary Mastery, and Speaking Ability among the Eleventh Grade Students of 

MAN 1 Semarang in Academic Year 2017/2018. Thesis. English Letters Study 

Program, Islamic Education and Teacher Training Faculty. 

Advisor : Zainal „Arifin, S.Pd., M.Pd 

Key Words : Correlation Study, Extroversion Personality, Vocabulary Mastery, 

Speaking Ability 

The thesis is aimed at verifying (1) whether there is positive correlation 

between extroversion personality and speaking ability; (2) whether there is 

positive correlation between vocabulary mastery and speaking ability; (3) whether 

there is positive correlation between extroversion personality, vocabulary mastery 

and speaking ability among the eleventh grade students of MAN 1 Semarang in 

the academic year of 2017/2018. 

This research used quantitative method; it was correlation design. It was 

carried out in March 2018 at MAN 1 Semarang in the academic year 2017/2018. 

There are three variables in this research, the ability of Extroversion personality 

and vocabulary mastery as the independent variable (X) and speaking ability as 

dependent variable (Y). The researcher conducted the research at MAN 1 

Semarang. The population of the study was all of the eleventh grade students of 

MAN 1 Semarang. The sampling technique was simple random sampling. The try 

out instrument was taken by 40 students and the sample of this study was 58 

students from 230 students. The researcher used questionnaire to obtain the data 

of extroversion personality and test to obtain the data of vocabulary mastery and 

speaking ability. The techniques used to analyze the data were Pearson Product 

Moment and Multiple Linear Regression. 

The results of the research are (1) there is a positive and significant 

correlation between extroversion personality (X1) and speaking ability (Y) 

because the correlation value 1 > rx1y > 0, that is 0.436 and ρ < α (0.001 < 0.05); 

(2) there is a positive and significant correlation between vocabulary mastery (X2) 

and speaking ability (Y) because the correlation value 1 > rx1y > 0, that is 0.667 

and ρ < α (0.002 < 0.05); (3) there is a simultaneously positive and significant 

correlation between extroversion personality (X1), vocabulary mastery (X2), and 

speaking ability (Y) because the correlation value 1 > rx1y > 0, that is 0.709. The 

results of the research, it can be concluded that extroversion personality and 

vocabulary mastery can support speaking ability. 
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CHAPTER I 

INTRODUCTION 

 

 

A. Background of the Study 

Language is a means of communication. It connects people with 

different cultures, places, thoughts, and many other differences. Language is 

an important tool of human communication. Communication is a process to 

convey ideas to other people. They communicate to maintain relationship 

among society. 

English is the most important language in the world because it is an 

international language. One of the most important functions of English  is to 

be an instrument of communication. The goal of learning a foreign language 

is sited on reaching of the communication ability (Littlewood, 1981:1). This 

suggest that learning English is not only learning grammar or structure but 

also learning how to apply and use this language for communication. 

Teaching English covers four skills; listening, speaking, reading and 

writing. All of the skills are taught in order to achieve integration in learning. 

Among the four skills, speaking is believed to be the most difficult skill to be 

learned. It is needed especially for oral communication. There are many 

difficulties to be found in this skill. It makes the teacher working hard in 

conveying English for the student because there are many materials that are 

conveyed by the teacher to the students, such as: speaking skills, 

pronunciation, vocabulary, grammar, etc. It also involves many aspects like 

cognitive, psychological, and psychomotor aspects. 
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Speaking is a very significant skill in language since it is used for 

expressing our ideas, getting information and messages. A lay man likes to 

judge the success of learning language from the ability to express their ideas 

orally. It is the case that the goal of people learning language is to be able to 

speak it. By English subject given to the students they expected to have good 

speaking ability to communicate: they are able to express themselves in 

English such as to interview, to give speech, debate, and many others. 

In order to have a good speaking ability, especially in English, people 

must have some other supplementary skill to support their speaking ability. 

Bailey and Savage (1994:vii) (in Fauziati, 2010:15) says that “Speaking in the 

second or foreign language has often been viewed as the most demanding of 

the four skill”. There are difficulties in speaking ability, the students have to 

master vocabulary and listening skill, fluency, accuracy, grammatical 

competence, sociolinguistics competence, discourse competence, strategic 

competence, etc. Vocabulary mastery is especially needed to develop 

speaking ability. Some research findings disclose that students who have 

acquired more vocabularies will be more likely to articulate and communicate 

the message. It means, when students have good vocabulary mastery, they 

will be good in speaking too. Speaking ability cannot be separated from 

vocabulary mastery. 

Mastering vocabulary is important since it is one of language elements 

that  influence all the language skills. So, what students need first before they 

are going to speak is know what words they want to say. Fauziati (2002:167) 

says the definition of vocabulary is very important for second  language 
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learners, only with a sufficient vocabulary learners can effectively express 

their ideas both in oral and written form.  

Another thing that effects speaking ability is vocabulary mastery. 

Vocabulary is part of  language, so it is impossible to avoid vocabulary in 

using English language. It is also supported by Allen (1983:7), he says that 

the students must be mastering vocabulary in English text, without it they 

cannot speak or understand the language. Because of that, the students should 

be learn more new vocabulary then discuss the meaning of words. So, the 

students’ vocabulary and their speaking ability are good. 

There are many factors that influence people to succeed to learn 

English, especially to acquire speaking ability. Those can come from either 

the outside of learners or inside of learners. Among them are motivation, 

personality, environment, culture, teaching materials and techniques. 

Personality plays an important role to improve speaking ability.  

Based on Jung (in Howard, 2008:134), there are two kinds of 

personality. They are extrovert personality and introvert personality. 

Everyone has extrovert and introvert personality, but one of them will be 

more dominant than other. Extroverts tend to outside themselves. They are 

easy to make a friend in society, tend to strike and are easily influenced by 

other people’s emotions. Introverts are more focused on itself. In general, 

they will be busy with their experience which other people regard as the 

attitude of indifference.  

One of the problems coming from the inside is lacking of 

extroversion. Brown (2007:167)  explains that extroversion is a potential and 
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very important factor in second language acquisition,  especially in gaining 

speaking ability. Extroversion is beneficial for the learners since it provides 

chance for them to practice speaking. Therefore, there should be efforts that 

enable that second language learner to take advantages that characterize 

extroversion. Eysenck (in Johnson, 2001:149) describes that extroversion 

personality likes to socialize, like a party, have a lot of friends, need friend to 

speak, and don’t like to learn by themselves. He delighted excitement, take a 

chance, full of confidence, and reacts promptly, generally a full individual 

encouragement and spontaneous. delighted excitement, take a chance, full of 

confidence, and reacts promptly, generally a full individual encouragement 

and spontaneous. 

When researcher conduct pre-observation at the time English subject 

in MAN 1 Semarang, the researcher found student’s problem in speaking 

learning. When the students practiced speaking English, some of them feel 

enjoy eventhough they made some mistakes. They expressed their thought 

freely. Meanwhile, the other avoided to speak and preferred to keep silent. 

Students having high expressiveness are easier to produce words than 

inhibited students. The expressiveness included as a part of extroversion 

personality whether the extrovert personality influence speaking ability or 

not. 

The researcher choose the eleventh grade of MAN 1 Semarang as a 

population because if the tenth grade is new students who still need adaption 

with environment of school and teachers have not known the level of 

student’s personality and their English ability especially speaking. Meanwhile 
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the twelfth grade will have done final exam that cannot be used as a sample in 

this research. 

In the school, sometimes there are some students who are inactive 

become the winner in the class, but it is possible if active students can exceed 

their achievement. Learning outcomes in schools are usually indicated by the 

value of report, especially English subject which is resulted from the 

cumulative value of the various skills. There are listening skill, writing, 

reading, and speaking skills. Although many students who have weakness in 

speaking. They are more careful in using words. Meanwhile, extrovert 

students tend to be talkative, excited, carefree, and responsive in 

conversation. They are always ready with answers and like the chance. They 

can speak fluently and freely. These indicate that extrovert students have 

better speaking ability while the introvert students are worse in speaking. 

Then how much the extrovert can influence the success in speaking, in this 

research the researcher tries to investigate the correlation between 

extroversion personality, vocabulary mastery, and speaking ability. 

Based on the description above, the researcher wants to carry out 

research to know whether there is a positive correlation between extroversion 

personality, vocabulary mastery and speaking ability especially for the 

eleventh grade students of MAN 1 Semarang entitled “The Correlation 

between Extroversion Personality, Vocabulary Mastery, and Speaking Ability 

among the Eleventh Grade Students of MAN 1 Semarang in the Academic 

Year of 2017/2018”. 
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B. Identification of the Problem 

Based on the background of the study above, some problems that are 

found as follows: 

1. The factors that influence the speaking ability. 

2. The students have low extroversion personality. 

3. The students have low in learning speaking. 

4. The correlation between extroversion personality and speaking ability. 

5. The correlation between students’ vocabulary mastery and speaking 

ability. 

6. The correlation between extroversion personality, vocabulary mastery, and 

speaking ability. 

 

C. Limitation of the Study 

Based on identification of the problem above, it is known that the 

problems affected by many factors, so the researcher needs to be limited. This 

study focuses on three variables, namely extroversion personality and 

vocabulary mastery as independent variables and speaking ability as 

dependent variable.  

In conducting this research, the researcher choose MAN 1 Semarang 

as the place of the research because MAN 1 Semarang is one of favorite 

school of society that has the advantage that many achievement that achieved. 

Based on it, the researcher choose this school because of many achievement 

of competition achieved based on their personality. 
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Second, because the students of MAN 1 Semarang have knowledge on 

vocabulary. The researcher choose eleventh grade students as the sample of 

research because they have knowledge more on vocabulary. At psychology 

view, eleventh grade is great position in the stable mental. Moreover tenth 

grade who still looking for their confidence or twelfth grade who busy to 

preparing the National Examination. 

 

D. Problem Statement 

Based on the background of the study and problem limitation, the 

problems of the study as follows: 

1. Is there a positive and significant correlation between extroversion 

personality and speaking ability? 

2. Is there a positive and significant correlation between vocabulary mastery 

and speaking ability? 

3. Is there a positive and significant correlation between extroversion 

personality, vocabulary mastery, and speaking ability? 

 

E. The Objective of the Study 

In line with the problems statement above, the objective of study as follows: 

1. To know whether there is a positive and significant correlation between 

extroversion personality and speaking ability. 

2. To know whether there is a positive and significant correlation between 

vocabulary mastery and speaking ability. 



8 
 

 

3. To know whether there is a positive and significant correlation between 

extroversion personality, vocabulary mastery and speaking ability. 

 

F. The Benefit of the Study 

The benefits of the study result are as follows: 

1. Theoretical benefits 

To prove whether there is correlation study between extroversion 

personality, vocabulary mastery and  speaking ability at the eleventh grade 

students of MAN 1 Semarang. Through this research was expected to 

improve knowledge either for teacher or society. So it can be used as the 

reference in improving and developing speaking ability in the school. The 

researcher also hopes that this researcher will give contribution for the 

development of education in Indonesia. 

2. Practical benefit 

a. For the students 

1) To help the students understanding their characteristics, so they can 

solve their problems in achievement speaking ability by 

themselves. 

2) To give motivation for students to develop their extroversion 

personality and to give knowledge for students to master the 

vocabulary. 

3) To give knowledge for students to master the vocabulary. 
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b. For the teacher 

For the teacher, result of this research to help the teachers 

understanding the characteristics of their students, so they can help the 

students improve their speaking skill and they can choose the best 

method to teach their students based on their characteristics and to 

know the importance of personality for the students. 

c. For the researcher and the other 

1) It gives information to the other who wants to know the factors 

which can influence speaking ability. 

2) It is hoped that the result of this study will be helpful in 

determining the strategies in English speaking teaching and 

learning. 



CHAPTER II 

REVIEW ON RELATED LITERATURE 

 

 

A. Theoretical Description 

1. Review on Speaking Ability 

a. The Definition of Speaking Ability 

Language is a tool used to communicate with others. One of the 

ways is by speaking. Speaking here means the individual’s ability in 

expressing his or her ideas. Because of speaking individual can express 

feeling or something he or she directly wants to convey. 

For building a good communication people must have a good 

speaking ability. To know about the notion of speaking itself the 

following are the definitions of speaking stated by some experts. 

Speaking is productive rather than receptive ability because it is as a 

way in which the language system is manifested through the use of the 

organs of speech. On the other hand, speaking can be considered as 

productive and receptive ability because it is used in communication 

activity. People use it both as listener or speaker. Widdowson 

(1978:59) states speaking is a part of reciprocal exchange in which 

both reception and production play a part. In his theory, he emphasizes 

speaking as a reception and production. 

Nunan (1999:26) says that speaking is a process consisting of 

short, often fragmentary utterances in a range of pronunciation. Lewis 
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and Hill (1993:54) states that speaking cover many things in addition 

to the pronunciation of individual sounds. 

Thornbury (2005:1) says that speaking is interactive and 

requires the ability to cooperate in the management of speaking turns. 

It also typically takes place in real time with little time for detail the 

plan. In addition, Brown (2004:140) states that speaking is a 

productive skill that can be observed directly and empirically. 

Referring to the definition above, it can be said that speaking score is 

measure of oral production. He adds that speaking is the product of 

creative construction of linguistic strings; the speaker makes choice of 

lexicon, structure, and discourse. Speaking is categorized as success 

speaking when the listener can understand what the speaker says. 

In conclusion, speaking ability is the students’ capability of 

speech or increasing speaking or talking. The functions of speaking 

ability are to express an idea, feeling, thought, and needs orally. 

 

b. The Characteristics of Successful in Speaking Ability 

Spoken language is easy to perform, but in some cases it is 

difficult (Brown, 2001:270). Based on Ur (1996:120), there are 

characteristics of a successful speaking activity: 

1) Learners talk a lot 

As much a possible of the period of time allocated to the 

activity is in fact occupied by learners talk. This may be obvious, 

but often most time is taken up with teacher talk pauses. 
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2) Participation is even 

Classroom discussion is not dominated by a minority of 

talkative participants. All get chance to speak, and contributions are 

fairly evenly distributed. 

3) Motivation is high 

Learners are eager to speak because they are interested in 

topic and have something new to say about it, or they want to 

contribute to achieve a task objectives. 

4) Language is of an acceptable level 

Learners express themselves in utterances that are relevant, 

easily comprehensible to teach other, and of an acceptable level of 

language accuracy. 

In conclusion, the successful of speaking based on Ur consist 

of four points, they are learners talk a lot, participation is even, 

motivation is high, and language is of an acceptable level. 

 

c. Problem in Speaking Ability 

The learner have their own difficulties in learning the language. 

Particularly in improving speaking ability is not easy for the students. 

Based on Ur  (1996:121) those problems can be explained as follows: 

1) Inhabitation 

Unlike reading, writing or listening activities, speaking 

requires some degree of real-time exposure to an audience. Learners 

are often inhibited about trying to say thing foreign language in the 
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classroom: worried about mistakes or simply shy of the attention that 

their speech attract. 

2) Nothing to say 

Even they are not inhibited, you often hear learners complain 

that they cannot think anything to say, they have no motive to express 

themselves beyond the guilty feeling that they should be speaking. 

3) Low or uneven participation 

Only one participant can talk at a time if he or she is to be 

heard; and in large group, this means the each one will have only very 

little talking time. This problem is compounded of some learners to 

dominate, while other speaks very little or not a tall. 

4) Mother tongue use 

It is easier for the student to use their mother tongue in their 

class because it look naturally. Therefore, most of students are not 

disciplined in using the target language in the learning process. 

In conclusion, problem in speaking consist of four points, they are 

inhabitation, nothing to say, low participation, and mother tongue use. 

 

d. Testing Speaking 

Based on Thornburry (2005:123), the types of speaking are: 

1) Interview 

An interview is conducted by calling out individuals one by 

one for their interviews. Interviews is easy to set up but it is not 

conductive to test informal, conversational speaking styles. 
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2) Live monologue 

The candidates prepare and present a short talk on pre-selected 

topic. This type of test eliminates the interviewer effect and provides 

evidence of the candidate’s ability to handle on extended turn, which 

is not always possible in interviews. 

3) Recorded monologue 

Recorded monologue is less stressful than a more public 

performance. It is more practicable than live-monologue. Learners can 

record themselves on certain topic talk.  

4) Role plays 

A learner must perform a certain role in the classroom. 

Another role can be performed by another student or teacher. 

5) Collaborative tasks  

These are similar to role plays except that the learners are not 

required to assume a role but simply to be themselves. The learner’s 

interactive skills can be observed in circumstances that closely 

approximately real-life language use. 

Ur (1996:39) suggests that the techniques of speaking test to test oral 

proficiency are as follows: 

1) Question and answer 

In this test, the teacher and the students are involved in 

question and answer using the target language. The answer can be in 

short or long answer based on the questions asked. 

 



15 
 

2) Monologue 

In this type of test, students are required to perform a 

speaking performance at a topic given. 

3) Making dialogue 

A pair of students is given a topic and then they are expected 

to perform a dialogue based on the topic given. 

4) Role plays 

Teacher hands out a card role to students. Each student gets a 

particular role to perform. The students perform in pair or group to 

conduct the speaking. 

5) Debate 

Some students are divided into two groups pro and contra. 

They are given a topic and then ask each other to give their opinion 

about the topic based on their group role. 

In conclusion, types of speaking performance based on Thornbury 

and Ur have each type. From the several basic types speaking ability 

performance above, the researcher used monologue as basic speaking in 

this research. 

 

e. The Criteria of Assessing of Speaking 

The goal of teaching speaking communicative skill achievement. 

Speaking ability is not merely speaking, but it is more than talking. 

Therefore, language learners should be able to use their thought and 

sensitivity. Thornbury (2005:127) explains that there are two ways for 



16 
 

assessing speaking ability, they are holistic scoring (a single score on the 

basis of an overall impression) and analytic scoring (giving separate score 

for different aspects of the task). He also says that four or five categories 

seem to be the maximum that even trained scorers can handle at one time. 

Thornbury mentions those categories as grammar and vocabulary, 

discourse management, pronunciation, and interactive communication.  

Based on Brown (2004:4) assessment is an outgoing process that 

encompasses a much wider domain. He also says that four categories to 

assess speaking. There are fluency, grammar, vocabulary, pronunciation. 

This research used Haris’  scoring categories to asses speaking. Because 

the Haris’ scoring categories have more complete categories  than 

Thornbury and Brown’s scoring categories.  

In this research the researcher decided to use the scoring criteria by 

Haris (1997:81-82), there are some component should be recognized by 

language learners in learning speaking, namely: 

 
Table 2.1 The Criteria of Assessment of Speaking 

 

Aspects Competency Score 

Pronunciation 

Have few traces of foreign accent 5 

Always intelligible, thought one in 

conscious of a definite accent 
4 

Pronunciation problems necessitate 

concentrated listening and occasionally lead 

to misunderstanding. 

3 

Very hard to understanding because of 

pronunciation problems, must frequently be 

asked to repeat. 

2 

Pronunciation problems so severe as to 

make speech virtually unintelligible. 
1 

Grammar 

Makes few noticeable errors of grammar or 

word order. 
5 

Occasionally makes grammatical and/or 4 
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word order errors which do not, however, 

obscure meaning. 

Makes frequent errors of grammar and 

word-order which occasionally obscure 

meaning 

3 

Grammar and word order errors make  

comprehension difficult. Must often 

rephrase sentences and/or restrict him to 

basic patterns. 

2 

Error in grammar and word-order so severe 

as to make speech virtually unintelligible. 
1 

Vocabulary 

Use of vocabulary and idioms is virtually 

that as a native speaker. 
5 

Sometimes uses in appropriate terms and/or 

must rephrase ideas because of lexical 

inadequacies. 

4 

Frequently uses the wrong words; 

conversation somewhat limited because of 

adequate vocabulary. 

3 

Misuse of words and very limited 

vocabulary make comprehension quite 

difficult. 

2 

Vocabulary limitations so extreme as to 

make conversation virtually impossible. 
1 

Fluency 

Speech as fluent and effortless as that of a 

native speaker. 
5 

Speed of speech seems to be slightly 

affected by language problems. 
4 

Speed and fluency are rather strongly 

affected by language problems. 
3 

Usually hesitant, often forced into silence 

by language limitation. 
2 

Speech is as halting and fragmentary as to 

make conversation virtually impossible. 
1 

Comprehension 

Appears to understands everything without 

difficult 
5 

Understands nearly everything at normal 

speed, although occasional repetition may 

be necessary 

4 

Understands most of what is said at slower 

than normal speed with repetitions. 
3 

Has great difficulty following what is said. 

Can comprehend only “social conversation” 

spoken slowly and with frequent repetitions. 

2 

Cannot be said to understand even simple 

conversational English. 
1 
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2. Review of Vocabulary Mastery 

a. Definition of Vocabulary Mastery 

In learning English, vocabulary cannot be separated from other 

English language skills. It plays an important role in understanding the 

language holistically. Vocabulary knowledge is the single most important 

area of second language competence regarded as academic achievement. 

Hatch and Brown (1995:1) define vocabulary as a list or a set of words 

for particular language, or a list of words that individual speaker of a 

language might use. Burns and Broman (1975:295) state that vocabulary 

is defined as the total number of word (with rules of combining them) 

used by person, class or profession to make up language either in oral 

written communication. Hornby (1995:1331) says that vocabulary is a 

list or a set of words with their meaning. 

In Oxford Advanced Learner’s Dictionary, mastery is complete 

knowledge or great skill. Based on Webster (2002:714) states that 

mastery is skill or knowledge that makes one master of a subject. 

From the definition above, it can be concluded that vocabulary 

mastery is knowledge of a list or set of words for a particular language to 

make up language either in oral or written communication. 

 

b. The Importance of Vocabulary Mastery 

Krashen and Terrel (1995:155) state that vocabulary is basic to 

communication. They also mention that if students do not recognize the 

meanings of the key words used by who address them, they will be 
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unable to participate in the conversation. Students should be able to 

produce lexical items to convey their meaning for expressing some idea 

or ask for information. 

Krashen and Terrel (1995:155) explain that if students know 

about the morphological and syntax of an utterance addresses to them but 

they do not know about the meanings of the key lexical items, they will 

be unable to participate in communication. 

McCharty (1990:8) states the importance of vocabulary in 

language learning “No matter how successfully sounds of L2 are 

mastered, without words to express a wider range of meanings, 

communication in an L2 just cannot happen in any meaningful way”. 

Then, Wilkins (in Thornburry, 2002:13) says that without grammar, very 

little can be conveyed, but without vocabulary nothing can be conveyed. 

Based on the information above, it can be conclude that mastering 

vocabulary is very important to the students. By mastering the 

vocabulary, students can participate in conversation or communication 

with others. 

 

c. Kinds of Vocabulary Mastery 

Haycraft (1997:44) explains that vocabulary is divided into the 

receptive vocabulary  and productive vocabulary. Receptive vocabulary 

is the words that students can recognize and understand when they occur 

in context, whereas productive vocabulary is words which students 

understand, they can produce correctly and use constructively in 
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speaking and writing. Harris (1997:48) says that vocabulary can be 

categorized into passive or active vocabulary. Active vocabulary is the 

words usually used in the speech and writing activity, while passive 

vocabulary is the words usually uses in reading. Harmer (1991:150) 

states that basically students have four different vocabularies, namely 

speaking vocabulary, listening vocabulary, reading vocabulary, and 

writing vocabulary. Writing and speaking are language production, 

which belong to productive skills, while listening and reading involve 

receiving the message and they belong to the receptive skills. 

Based on the explanation above, it can be conclude that there are 

two kinds of vocabulary; receptive or passive vocabulary and productive 

or active vocabulary. 

 

d. Teaching Vocabulary 

Based on Ur (1996:60) there are some elements need to be taught 

in teaching vocabulary. They are: 

1) Form: Pronunciations and Spelling 

The learner has to know how a word is pronounced (it is 

pronunciation), and what it looks like (it is spelling). These are fairly 

obvious characteristics, and one or the other be perceived by the 

learner when encountering the item for the first time. In teaching, the 

teacher needs to make sure that both these aspects are accurately 

presented and learned. 
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2) Grammar 

The learner also needs to know the present or the past form of 

the sentences form of the verb, the plural noun or singular, etc. a 

words sometimes come grammatically.  

3) Collocation 

It deals with appropriateness of particular combination of words. 

The most common types of collocation are as follows: 

a) Subject noun + verb e.g. The dog barked 

b) Verb + object noun e.g. She takes her dogs 

c) Adjective + noun  e.g.  A nice car 

d) Adverb + past participle e.g. Badly injured 

4) Aspect of meaning 

In language teaching, this kinds of relationship is useful. The 

learner should recognize the words in different relationship. 

Synonyms, Antonyms, Hyponyms are some of the main ones. 

5) Word formation 

Certain vocabulary can be broken down into their components. 

The learners’ understanding in prefixes and suffixes can help them in 

knowing the meaning. That aspect will give the learners to know and 

learn foreign language. However, that aspect has to teach in match to 

the level of students. 

In conclusion, elements need to be taught in teaching vocabulary 

consist five points, there are form (pronunciation and spelling), grammar, 

collocation, aspect of meaning, and word formation. 
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e. Vocabulary Mastery   

Vocabulary mastery is then defined as students’ complete 

knowledge of meaning and form of words in context appropriately. 

Knowledge in vocabulary mastery concerns with words and meaning, 

generally words class and word meaning (Hatch and Brown, 1995:218). 

1) Word class 

Word class is the classification of words of a language 

depending on their function in communication. Word class 

membership is an important lexical feature, in this case are nouns, 

verbs, adjectives, and adverbs. 

a) Noun can be divided into subclasses. There are proper nouns and 

common nouns. There are also count nouns, mass nouns, abstract 

nouns, and concrete nouns. 

b) Verbs are words that denote action. Verbs that denote states rather 

than action seem less verb like. Process verbs which have no 

definite and points also seem less verb like than strong action. 

Hatch and Brown placed verbs into four classes: activities (eat, 

drink, look for), accomplishment (kill, build, paint a picture), 

achievement (recognize, find, lose, understand, hear), and states 

(love, know, desire, have). 

c) Adjectives are used to highlight qualities or attributes. Certain 

adjectives are typically used to describe particular nouns. For 

example, light, bright, dark, and dull are used with color nouns. 

Adjectives can point out positive or negative qualities. 
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d) Adverbs are similar to adjective in many ways although they 

typically assign attributes to verbal, to clauses or to entire 

sentences rather than nouns. Locative adverb, like here and there 

are used very early by young children as ways of pointing to the 

location of subjects. Time adverb, like now, then and yesterday 

are used second language learners are an initial way to mark. 

2) Word Meaning 

The two important issues in word meaning students’ usually 

get difficulties to infer are synonymous and antonymous. 

a) Synonyms 

Hatch and Brown (1995:19) says that synonyms are words 

that share meaning. Although dictionaries list synonyms as words 

with similar meanings, the fact X is a synonym for Y does not 

mean that Y is necessarily a synonym for X. one of the most 

important ways for making text together is with the use of 

synonyms or chains of related words. It might be selected words 

that are not synonymous but which still refer to the same object. 

b) Antonyms 

Hatch and Brown (1995:20) define antonyms as a words 

that mean the opposite. They present interesting problem for 

anyone seriously interested in semantic feature analysis. The 

feature on which the two words contrast can be identified. Many 

apparent opposites, however, are really extreme points on 

graduated classes. This is especially true of adjectives. Hot and 
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cold may seem like opposites, but temperature is scale, and it is a 

judgment as to what constitutes hot, warm, cool, and cold along 

the scale. The dimension is not just bisected into a plus and a 

minus value. In the same way, pairs like big-small, many-few, 

tall-short, happy-unhappy, and long-short are the opposite ends of 

scales. 

Vocabulary mastery in this research is the students’ knowledge 

concerning with words and meaning, including word class (noun, 

adjective, verb, and adverb) and word meaning (antonym and 

synonym). 

 

f. How to Test Vocabulary mastery 

There are several ways to test vocabulary of the learners. We 

know that a good knowledge of English vocabulary is important for 

everyone who wants to use the language. From the statement before, 

the knowledge of vocabulary is often tested. Based on Ur (1996:71) 

the ways are follows: 

1) Multiple Choice Test 

In this type of the test, the learners just choose the best 

answer what they want. 

2) Dictation 

Here the examiners will dictates the text and learners will 

write the word down. Dictation is an easy way of testing for the 

teacher because the preparation is minimal. 
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3) True or False 

The kinds of the test depend on the test or listening, the 

students have to answer the question that given before. 

4) Odd One Out 

The students only meaning is being tested. They have now 

way of being sure that all the item are known. But this is at least 

more interesting to do, and usually easy to mark. 

5) Gap Filling 

Many multiple-choice task described can be converted into 

gap filling or fill in the blank. The student should write or choose a 

word or phrase in the blank space. 

6) Sentence Completion 

This test (denotative) meaning only, but is “personalized” 

and interesting to do and read. 

7) Writing sentence 

Spelling and pronunciation of the item are not tested, but 

most other aspects are. This is a bit boring to do, and difficult to 

mark objectively, but does check the tester’s knowledge very well. 

8) Matching 

There are two group of words, students should match the 

one group that correlates with the other one. 
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9) Error correction 

The learner will give some of the sentences with errors, 

which concern mainly in grammar. 

10) Translation 

The learners receive some of the sentences in their mother 

tongue, and they have to translate into English. 

11) Cloze Test 

In cloze test, the knowledge of a wide range of words types 

including grammar words as well as content words.  

From all the kinds of the way to test vocabulary, the 

researcher used multiple-choice test. Based on Thornburry (2002:132) 

defines multiple choice test are a popular way of testing in that they 

are easy to score (a computer can do it), and they are easy to design.  

 

3. Review on Extroversion Personality 

a. The Nation of Personality 

Personality is the characteristic of people which causes 

consistency of feeling, thinking and behavior (Pervin, 2010:6). It means 

that the pattern of consistent behavior and quality in a person, as the 

quality of the environment that affect personality of people. People is the 

configuration of characteristics and behavior that comprises and 

individual’s unique adjustment to life, including major traits, interest, 

drives values, self-concept, abilities, and emotion patterns. Vandenbos 

(2015:782) define that personality is generally viewed integration or 
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totality, shaped by many forces, including: hereditary and constitutional, 

tendencies; physical maturation; early training; identification with 

significant individuals and groups; culturally conditioned values and 

roles; and critical experiences and relationship. 

Allport (in Feist, 1985:9) defines that personality is the dynamic 

organization within the individual of those psychological systems that 

determine his unique adjustments to his environment. Branca (in Pervin, 

2010:6) argues that personality represents those characteristics of the 

person or the people generally that account for consistent patterns of 

behavior. Eysenck (in Suryabrata, 1988:339) states that personality is the 

sum of actual a potential behaviors pattern of the organism determined by 

heredity and environment; it originates and develops trough the 

functional interaction of the main sectors into which these behavior 

patterns are the co native (character), the affective sector (temperament), 

and the somatic sector (constitution). 

Cook (1993:3) states that there are three reasons for being 

interested in personality, i.e. first, to gain scientific understanding, 

second, to access people and third, to change people. For cook, the first 

reason is theoretical means to gain scientific understanding of a person’s 

personality concerned with or involving the theory of a personality or a 

area of study rather than its practical application; while the second reason 

mean that personality can be as an access to understand a person 

behavior and attitude, then could change a person, the two reasons are 

relevant and can be applied in real life situation. 
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Some psychologists agree that personality is derived from the 

Latin “persona” that refers to a theatrical mask worn in Geek drama by 

Roman actors before the birth of Christ. The persona is used to the role 

one play in life. It reflects a false appearance to others, so that all actions 

are accepted in society. Human beings usually only show good behavior, 

so they use mask. 

Finally, personality is an organized combination of the 

characteristic of  person such as feeling, thinking and behavior. It is 

relatively permanent traits of characteristics within the individual that 

give measure of consistency to person’s behavior, and may be unique, 

different for each individual who is determined by heredity and 

environment. 

There are two kinds of personality. Jung (in Sujanto et al, 

1997:70) says that the type of personality consist of extrovert and 

introvert personality. Jung (in Howard, 2008:296) says that each person 

can have both tendencies, either extroversion but one of them is 

dominant.  

Jung (in Feist, 2009:116) states that extroversion is the attitude 

distinguished by the turning outward of physic energy so that person is 

oriented toward the objective and away from the subjective. Extrovert are 

more influenced by their surroundings than by inner world. Extroversion 

is an orientation of one’s interests and energies toward the outer world of 

people and things rather than the inner world of subjective experience. 

Extroversion is a broad personality trait and exist on a continuum of 
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attitudes and behaviors. Extroverts are relatively more outgoing, 

gregarious, sociable, and openly expressive (Vandenbos, 2015:403) 

Jung (in Feist, 2009:116) states that introversion is the turning 

inward of psychic energy with an orientation toward the subjective. 

Introverts are turned into their inner world with all its biases. Introversion 

is orientation toward the internal private world of one’s self and one’s 

inner thoughts and feelings, rather than toward the outer world of people 

and things. Introversion is a broad personality trait and exists on a 

continuum of attitudes and behaviors. Vandenbos (2015:561) says that 

introverts are relatively more withdrawn, retiring, reserved, quiet, and 

deliberate; they may tend to mute or guard expression of positive affect, 

adopt more skeptical views or positions, and prefer to work 

independently. 

Personality has two aspects. They are extrovert personality 

aspect and introvert personality aspect. The extrovert and  introvert 

aspects as follows by Eysenck (in Samini, 2004:15). The aspects of 

extrovert personality, they are: Activity, sociability, risk-taking, 

impulsiveness, expressiveness, reflective-ness, and irresponsibility. 

Although, the aspects of introvert personality are Inactivity, 

unsociability, carefulness, controlled, inhibition, and responsibility. 

From the explanation above, it can be concluded that the 

extroversion personality and  introversion personality has difference of the 

type. But, the focus of this research is extroversion personality. 
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b. Definition of Extroversion 

Pervin and John (1970:234) say the following “Eysenck suggests 

that a basic dimension of personality involves whether people tend to be 

unsociable, quiet, and passive (introvert) or sociable, outgoing, and active 

(extrovert). 

Iskandar (2000:46) states that what is mean by extroversion is 

one’s personality with which he enjoys getting together with others, loves 

meeting people and feels confident in attending social programs. He is not 

clumsy when talking with others in front of strangers. He is outgoing and 

sociable. Usually, it is easy for people with this type of personality to 

adapt to their new environment. Society also support this tendency.  

Eysenck and Eyenck (1975) and Myers (1962) (in Hamedi, et al, 

2015:286) demonstrate that extraverts tend to be open to the strangers and 

get socially mixed. Gale (1969) (in Hamedi, et al, 2015:286) define 

extraverts as the ones who are more restless and energetic in the restricted 

environments.  

Jung (in Feist, 2009:116) states that extroversion is the attitude 

distinguished by the turning outward of physic energy so that person is 

oriented toward the objective and away from the subjective.  

From the explanation above, it can be concluded that extroversion 

is one of the energetic personality that they prefer to connect with many 

people (socialize). 
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c. Types of Extroversion Personality 

Extroversion is one of personality dimensions which can be 

indicated through behavior. It is commonly contrasted with its antithesis, 

introversion. Someone who is extrovert tends to be easy going, friendly, 

impulsive, energetic, and sociable. Based on Vandenbos (2015:403) 

Extrovert are more influenced by their surroundings than by inner world. 

Extroversion is an orientation of one’s interests and energies toward the 

outer world of people and things rather than the inner world of subjective 

experience. Extroverts are relatively more outgoing, gregarious, sociable, 

and openly expressive. Extrovert like to travel, meet new people, see new 

place. They are typical adventurers, the life of the party, open and friendly. 

Rousuli (2013:32) says that extroverts are oriented to the outer 

world i.e. they are motivated from “without” and their attention is directed 

outward. They are people who are sociable, friendly, self confident and 

outgoing. Zafar (2012:34) says that extroverts are sociable, like parties, 

have many friends, and need excitement in everything they do; they are 

sensation-seekers and are lively and active. Extrovert are easily distracted 

from studying, partly as a result of their gregariousness and partly because 

of their weak ability to concentrate for long periods. 

From the explanation above, it can conclude that extroversion is 

one of personality that has type of personality they are relatively more 

outgoing, gregarious, sociable, openly expressive, like to travel, meet new 

people, see new place, like a party, friendly, have many friends and the 

other. 
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d. Aspects of Extroversion Personality 

Eysenck (in Samini, 2004:13) states that there are seven aspects of 

personality which are based on extrovert dimension. They are: 

1) Activity 

The person who has high activity tends to be active and energetic 

likes to do physical activities. He gets up early, does the activities 

quickly and does different kinds of tasks. 

2) Sociability 

A man having high extroversion usually has high sociability. He 

has many friends easily, likes to go to a party, likes to do social activity, 

likes to meet new friends, and feels happy in friendly situation. 

3) Risk-taking 

Human being having high risk-taking value likes to live in 

dangerous situation and seek jobs that ignore the risk. He does the jobs 

without paying attention on his own safety. 

4) Impulsiveness 

The person who has this value likes to do something 

spontaneously without thinking firstly and make a quick decision 

5) Expressiveness 

People having expressiveness tend to their feeling freely. They 

usually like to show their emotions such as sad, angry, afraid, and 

pleasant. They show that they have high extroversion. 
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6) Reflectiveness  

Reflectiveness appears in one’s behavior to show new ideas, 

something abstract, philosophical questions, discussion, speculation, 

and they tend to be thoughtful and careful. 

7) Irresponsibility 

Is one of types extroversion which tends to be less thorough, less 

reliable, and  unserious. 

In conclusion, extrovert personality is divided into seven aspects. 

They are activity, sociability, risk-taking, impulsiveness, expressiveness, 

reflective-ness, and irresponsibility.  

 

e. Extroversion Personality Measurement 

King (2016:22) states that there are two ways to measure the 

extroversion personality. They are: 

1) Self-Report Tests 

Self report test also called an objective test or an inventory, a 

method of measuring characteristics that directly asks people whether 

specific items describe their personality traits. Self-report personality 

tests include items such as “I love to go to party”. Respondents choose 

from a limited number of answer (yes or no, true or false, agree or 

disagree). Self-report tests consist of two types test, there are: 

a. MMPI (Minnesota Multiphasic Personality Inventory) is the most 

widely used and researched empirically keyed self-report 

personality test. Some of the MPPI scales measure characteristics 
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associated with psychological disorders, such as depression and 

schizophrenia. Other scales include masculinity/femininity and 

introversion. 

b. Assessment of the big five factors, unlikely empirically keyed 

test, measures of the big five generally contain items that are 

straightforward; for  instance, the trait “talkative” might show up 

on an extroversion scale. These items have what psychologists 

call face validity. A test item has face validity if it seems on the 

surface to fit the trait in question. Measures of personality traits 

include items that are both positive or negative for each trait. 

2) Projective Tests 

A personality assessment tests that presents individuals with an 

ambiguous stimulus and asks them to describe it or tell story about it 

to project their own meaning onto the stimulus.  

In this research, the researcher used self-report test to measure the 

extroversion personality. The researcher used questionnaire to measure 

students’ extroversion. 

 

B. Previous Study 

The researcher got additional references from the previous 

researches that relate to this study. The first researcher is conducted by 

Shahila Zafar (2012) the research was entitled “A Study on the 

relationship between extroversion-introversion and risk-taking in the 

context of second language acquisition”, from the International Journal of 
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Research Studies in Language Learning. Her finding showed that extrovert 

seem to take full advantage of language-use opportunities as they tend to 

be sociable, and are more likely to join groups, more inclined to engage in 

conversations both inside and outside the classroom. However, results 

have also concluded that a introverted personality may be better suited to 

classroom learning, especially reading and reading skills. Based on the 

result, the research has similarity with his research that extroverts seem to 

take full advantage. 

The second researcher is conducted by Reni Lia Ningrum in 2016, 

about “A Correlational Study Between Student’s Motivation and 

Vocabulary Mastery toward Students’ Speaking Ability at The Tenth 

Grade Students of Boarding School MAN 1 Surakarta in the Academic 

Year of 2013/2014”, English Education Department, The State Islamic 

Institute of Surakarta. The result of her research show that (1) there is a 

positive correlation between student’s motivation and speaking ability (rx1y 

= 0,880 > rtable = 0,296); (2) there is positive correlation between 

vocabulary mastery and speaking ability (rx1y = 0,880 > rtable = 0,296); (3) 

There is a positive correlation between vocabulary mastery and speaking 

ability (R = 0,881 > Fregression = 48,418 > 3,340). It means that the 

contribution of students’ motivation, vocabulary mastery toward speaking 

ability at the Boarding School of MAN 1 Surakarta. The similarity of 

Reni’s research and this research is researching about the contribution 

vocabulary Mastery and Speaking ability, and the difference is about the 

contribution of Student’s motivation in Speaking ability, but this 
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researches about contribution of extroversion personality in speaking 

ability. 

 

C. Rationale 

1. Correlation between vocabulary mastery and speaking ability  

Vocabulary mastery is important for students who want to get 

result on speaking. Fauziati (2002:167) says the definition of 

vocabulary is very important for second  language learners, only with 

a sufficient vocabulary learners can effectively express their ideas 

both in oral and written form. Since vocabulary mastery is the 

complete knowledge of word (the form and meaning of the word), it 

makes up a language. 

It is also supported by Allen (1983:7) says that the students 

must be mastering vocabulary in English text, without it they cannot 

speak or understand the language. It is clear that without vocabulary 

mastery, the students will find some difficulties in speaking. When 

someone says something, of course he or she needs some vocabulary 

to make his or her communication clearly. So, it can be said that the 

students who master vocabulary better will have a better speaking 

ability too. They can more easily express their idea in speaking and it 

can be said that word is the key of communication to convey meaning 

utterance. 

2. Correlation between extroversion personality and speaking ability 
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Speaking is very significant skill in language since it is used 

for expressing our ideas, getting information and messages.  In 

learning English, there are some difficulties that should be faced by the 

students. In this case, the personality is one of the important factor in 

learning English especially speaking. Based on Jung (in Howard, 

2008:134) there are two kinds of personality. They are extrovert 

personality and introvert personality. Everyone has extrovert and 

introvert personality, but one of them will be more dominant than 

other. Extroverts tend to outside themselves. They are easy to make a 

friend in society, tend to strike and are easily influenced by other 

people’s emotions. They have more opportunity to speak up fluently. 

Extrovert personality have significant role toward speaking ability. 

Based on the explanation above, the researcher assumed that the 

students having high extrovert personality will have high speaking 

ability. 

3. Correlation extroversion personality, vocabulary mastery and 

speaking ability  

One of the crucial aspects that influence speaking ability is 

vocabulary mastery. It is the key aspect of language learning, 

especially in speaking. If students master the vocabulary well, they 

will easily express their ideas in oral form. On the other hand, if they 

do not master the vocabulary well, it will be difficult for them to 

express their ideas in oral form. 
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Speaking ability can be determined from the inside and outside 

of the students. From the outside, it can be material, the place of the 

study, and so on. While from the inside of the learner, one of the 

factors is personality. Extroversion personality can be defined as 

behavior directed to others which is normally characterized by the 

activity, sociability, risk-taking, impulsiveness, expressiveness, 

reflectiveness, and responsibility. 

Therefore, it is assumed that learners who have mastered 

vocabulary and have high extroversion will have better ability in 

speaking. From the explanation above, it can be predicted that there is 

a positive correlation between extroversion personality, vocabulary 

mastery, and students’ speaking ability. To prove the prediction, it 

should be tested by research. 

 

D. Hypothesis 

Based on the theory related to this study, the hypothesis in this 

research as follows: 

1. There is a positive correlation between extroversion personality and 

speaking ability? 

2. There is a positive correlation between vocabulary mastery and 

speaking ability? 

3. There is a positive correlation between extroversion personality, 

vocabulary mastery and speaking ability? 



CHAPTER III 

RESEARCHER METHODOLOGY 

 

 

A. Research Method 

The design of this research is correlation. Arikunto (2006:270) states 

that correlation is a design whose goal is to find whether or not there is a 

relation between two or more variables if there is, how strong that relation. 

The reason for choosing this design is that the researcher wants to know the 

strength of the relation of two or more variables based on correlation 

coefficient. 

This result used the correlation method. Creswell (2012:21) explains 

that correlation design is procedures in quantitative research in which 

investigators measure the degree of association (or relation) between two or 

more variables using the statistical procedure of correlation analysis. Based 

on Ary (2010:350) Correlation research produces indexes that show both the 

direction and the strength of relationships among variables, taking into 

account the entire range of these variables. This index is called a coefficient 

of correlation. He also explains that the coefficient can range in value from 

+1.00 (indicating a perfect positive relationship) through 0 (indicating no 

relationship) to -1.00 (indicating a perfect negative relationship).  

This research has two kinds of variables, independent variable and 

dependent variable. 

1. The independent variables (predictor variable) 

a. extroversion personality (X1)  
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b. vocabulary mastery (X2).  

2. The dependent variable (criterion variable) is speaking ability (Y). 

The correlation between three variables can be seen in the figure 3.1. 

 

 

 

 

 

 

Figure 3.1. the schema of the correlation between extroversion personality, 

vocabulary mastery and speaking ability 

 

B. The Setting of the Research 

1. The Place of the Research 

The research was carried out at the eleventh grade of MAN 1 

Semarang. It is located at Jl. Karanggede Suruh KM 2. 

2. The Time of the Research  

The researcher conducted the research in March until April 2018. 

 

Table 3.1 The Schedule of the Research 

No  Activities 
Month in 2017/2018 

Nov Dec Jan Feb Mar Apr 

1 
Submission Of 

The Tittle              

2 

Determination 

Of The Tittle 

With The 

Advisor              

EXTROVERSION 

PERSONALITY 

(X1) 

VOCABULARY 

MASTERY 

(X2) 

SPEAKING ABILITY 

(Y) 
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4 

Making A 

Thesis 

Proposal              

5 
Consulting the 

proposal 

      

6 

Conducting 

Examination of 

the Thesis 

Proposal              

7 
Conducting 

Research              

8 

Analyzing and 

Writing the 

Thesis 
      

9 
Consulting the 

Thesis 
      

10 

Report and 

Submitted 

Chapter IV and 

V 
       

C. The Population, Sampling, and Sample of the Research 

1. The Population of the Research 

Arikunto (2006:130) defines population as whole of subjects in 

the research. The population can be small or large. Creswell 

(2012:142) says that population is a group of individuals who have the 

same characteristics. From the statements above can be concluded that 

population is the whole of subjects or individuals who have the same 

characters in the research. 

The population of this research is all the eleventh grade 

students of MAN 1 Semarang in the Academic year of 2017/2018. 
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Table 3.2 The Total Students of the Eleventh Grade 

No Class Number of the Students 

1 XI IKA 1 30 

2 XI IKA 2 30 

3 XI IIS 1 30 

4 XI IIS 2 28 

5 XI MIA 1 28 

6 XI MIA 2 28 

7 XI MIA 3 28 

8 XI MIA 4 28 

Total 230 

 

2. The Sampling of the Research 

Creswell (2012:142) says that sampling is a group of 

individuals (or group of organization) with some common defining 

characteristic that researcher can identify and study.  

In this study, the researcher used simple random sampling. 

Sugiyono (2007:62) says that one of the famous ways in statistics to 

get the representative sample is simple random sampling. This is a 

method that gives every member of the population an equal chance of 

being selected in the study. The steps of selecting the sample were as 

follow: 

a. Listing all of the students 

b. Writing down the students’ code numbers in small papers  

c. Rolling the paper well 

d. Putting the rolled papers into a container 

e. Shaking the container well of several times 
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f. Taking 7-8 students of each class, 

In this research, the researcher  took 58 students to be a sample 

in this research. 

3. The Sample of the Research 

Creswell (2012:142) defines that a sample is a subgroup of the 

target population that the researcher plans to study for generalizing 

about the target population. Based on Arikunto (2006:134), if the 

population is less than 100 respondent, it will be better to take them all 

as a sample. So, the sample of the research is the population research. 

But, if the subject of the research is large, the researcher can take about 

10-15% or 20-25% or more. 

 In this research, the researcher took 25% of the population as 

the sample. It has about 58 students from 230 students as a sample. 

 

D. The Technique of Collecting the Data 

Before analyzing the data, the researcher collected the data to 

carry out the research. The main components of the technique of collecting 

the data are follows: 

1. The Instrument of Collecting Data 

a. Questionnaire 

Questionnaire is used to get the data of the students’ 

personality. Questionnaire is a list of questions. Sugiyono 

(2010:142) A questionnaire is a technique of collecting data using 

some written questions that must be answered by the respondents. 
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In the study, the researcher uses questionnaire to investigate and to 

collect information about the students’ extroversion. The type of 

the questionnaire is closed-type questionnaire. It is a questionnaire 

which answers the questions are provided so that the respondents 

only choose the suitable one in the answer. 

The researcher used the Likert scale as a method of 

summated ratings the questionnaire data. Rensis Likert (in Ary, 

Donald, 1985:195), Likert scale has been one of the most widely 

and successfully used techniques to measure attitudes toward a 

topic by asking respondents to indicate whether they strongly 

agree, agree, are undecided, disagree, or strongly disagree with 

each of series of statements about the topic. The score rages from 

1-5 can be seen at the table below: 

 

Table 3.3 Category Score of Likert Scale 

 

Statement 
Option 

SS S R TS STS 

Positive 5 4 3 2 1 

Negative 1 2 3 4 5 

 

SS = Sangat Setuju   TS = Tidak Setuju 

S = Setuju    STS = Sangat Tidak Setuju 

R = Ragu-ragu 

 

The researcher made the questionnaire based on the aspect of 

extroversion personality by Eysenck (in Samini, 2014:13). The 

questionnaire consist of 28 items and each item has five options 

with the scale of scoring from 1 to 5. 
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b. Test  

Brown (2004:3) test as a method of measuring a person’s 

ability, knowledge, or performance in a given domain. As a 

method, a set of techniques, procedures, or items requires 

performance on the part of the test taker. He explains that those 

characteristics of object such as skills, knowledge, ability, and 

interest of individual or group. This research used test to obtain the 

data of students’ vocabulary mastery and speaking ability. 

1) Test of vocabulary mastery 

The test of vocabulary mastery that used in this 

research is multiple choice test which have 5 alternatives (A, 

B, C, D and E) to know the students’ vocabulary mastery. 

There are 40 questions to test vocabulary mastery, the question 

consist of 6 indicators, they are aspect of meaning (synonym 

and antonym), collocation, grammar, word formation, and 

pronunciation and spelling. 

The score of test is amount of correct answer. The 

students get 1 point in every correct answer and get 0 in every 

incorrect answer.  

2) Test of speaking ability  

The oral test used to measure students’ speaking ability. 

The researcher asked the students one by one to explain how to 

make one food or drink (fried rice or a cup of coffee) in front 

of class. The researcher gave 5 minutes to prepare it, and then 



46 
 

asked the students to come forward randomly. The researcher 

makes the test based on the syllabus of eleventh grade. 

The criteria of scoring for the assessment of speaking 

ability test are presented as follows: 

Pronunciation 5 

Vocabulary 5 

Grammar  5 

Fluency  5  

Comprehension  5+ 

   25 

 

2. Validity and Reliability of Instrument 

An instrument can be said to be a good one if it is valid and 

reliable. Before the instruments where used, they had to be tried out. It 

was intended by this test to find out the validity and reliability of the 

instruments.  

a. Validity of the instrument 

Ary et all (2010:225), validity is the most important 

consideration in developing and evaluating measuring instruments. 

He also states that validity is defined as the extent to which an 

instrument measures what it claimed to measure. There are two 

kind of validity; internal and external validity. In this study, the 

researcher uses internal validity since the researcher analyzes the 

items of instruments whether or not they are appropriate to use. 
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To measure the validity of extroversion personality and 

vocabulary mastery the researcher used Product Moment Formula 

assisted by SPSS 20 for Windows. The formula is as follows: 

      
  ∑     ∑   ∑  

√   ∑    ∑      ∑    ∑    
 

Information: 

rxy : The coefficient of correlation between X and Y 

N : The number of the students 

x : The sum of the scores of each item 

y : The sum of the scores of each student 

The criteria of validity test is that the test is valid if 

robtained is higher than rtable  and it is invalid if robtained is lower than 

rtable. In this computation that used SPSS 20 program for 

Windows, the researcher used level of significance = 0.05 (5%). 

There are two data of validity instrument, namely; extroversion 

personality and vocabulary mastery. After being computed the 

data try out of two instruments of students that consist of 40 

students, we got the result as follows: 

1) Validity of extroversion personality 

The criteria of validity instrument of extroversion 

personality becomes valid if Sig. < α and it becomes invalid 

if Sig. > α. The validity instrument of extroversion 

personality can be seen in the table below. 
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Table 3.4 The Validity of Extroversion Personality 

 

Item Sig. α Result 

1 0.000 0.05 Valid 

2 0.000 0.05 Valid 

3 0.000 0.05 Valid 

4 0.000 0.05 Valid 

5 0.073 0.05 Invalid 

6 0.001 0.05 Valid 

7 0.000 0.05 Valid 

8 0.000 0.05 Valid 

9 0.000 0.05 Valid 

10 0.000 0.05 Valid 

11 0.101 0.05 Invalid 

12 0.001 0.05 Valid 

13 0.000 0.05 Valid 

14 0.000 0.05 Valid 

15 0.452 0.05 Invalid 

16 0.000 0.05 Valid 

17 0.000 0.05 Valid 

18 0.000 0.05 Valid 

19 0.000 0.05 Valid 

20 0.000 0.05 Valid 

21 0.000 0.05 Valid 

22 0.000 0.05 Valid 

23 0.000 0.05 Valid 

24 0.000 0.05 Valid 

25 0.001 0.05 Valid 

26 0.004 0.05 Valid 

27 0.073 0.05 Invalid 

28 0.073 0.05 Invalid 

 

Based on the table above, the researcher concluded 

that 23 items of extroversion personality questionnaire are 

valid. The result shows that the test is in the valid criteria 

because Sig. < α. 
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2) Validity of Vocabulary Mastery 

The criteria of validity instrument of vocabulary 

mastery becomes valid if Sig. < α and it becomes invalid if 

Sig. > α.. The validity instrument of vocabulary mastery can 

be seen in the table below. 

 

Table 3.5 The Validity of Vocabulary Mastery 

 

Item Sig. α Result 

1 0.000 0.05 Valid 

2 0.014 0.05 Valid 

3 0.000 0.05 Valid 

4 0.000 0.05 Valid 

5 0.480 0.05 Invalid 

6 0.009 0.05 Valid 

7 0.002 0.05 Valid 

8 0.000 0.05 Valid 

9 0.000 0.05 Valid 

10 0.000 0.05 Valid 

11 0.000 0.05 Valid 

12 0.192 0.05 Invalid 

13 0.712 0.05 Invalid 

14 0.000 0.05 Valid 

15 0.001 0.05 Valid 

16 0.000 0.05 Valid 

17 0.942 0.05 Invalid 

18 0.000 0.05 Valid 

19 0.003 0.05 Valid 

20 0.013 0.05 Valid 

21 0.037 0.05 Invalid 

22 0.005 0.05 Valid 

23 0.003 0.05 Valid 

24 0.000 0.05 Valid 

25 0.003 0.05 Valid 

26 0.007 0.05 Valid 

27 0.879 0.05 Invalid 

28 0.000 0.05 Valid 

29 0.468 0.05 Invalid 

30 0.010 0.05 Valid 

31 0.000 0.05 Valid 

32 0.119 0.05 Invalid 

33 0.000 0.05 Valid 
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No Sig. α Result 

34 0.001 0.05 Valid 

35 0.003 0.05 Valid 

36 0.000 0.05 Valid 

37 0.000 0.05 Valid 

38 0.000 0.05 Valid 

39 0.002 0.05 Valid 

40 0.533 
 

0.05 Invalid 

 

Based on the table above, the researcher concluded that 

31 vocabulary mastery questions are valid. The result shows that 

the test is in the valid criteria because Sig. < α. 

 

3) Validity of the Speaking Ability 

A valid instruments means that the instrument is suitable 

for measuring the object that will be measured. To determine 

whether the instrument is valid or not using content validity 

approach is by making rational judgment, whether the 

instruments contains enough requirements to measure all 

variable indicators. Based on Hopking (in Siregar, 2013:89) who 

said the determination of the instrument of content validity 

associated with the logical analysis. To examine content validity 

instrument, it can use to expert opinions (expert judgment) the 

instrument is consulted to the expert, then the expert determine 

whether the instruments is valid or not to measure the variable.  

In this research, the validity of speaking ability test 

measured by using the theory of content validity and consulted 
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to the expert and accorded to the syllabus. Besides that, the 

expert judgment is consulted to Zainal ‘Arifin, S.Pd., M.Pd as 

the advisor and Siti Aminah, S.Pd as the English teacher of 

MAN 1 Semarang. Based on syllabus of MAN 1 Semarang, one 

of the materials of speaking is procedure text. 

The research can concluded and summarized the result of 

the try out are as follows: 

1. From 28 items of extroversion personality questionnaire, 23 

items are valid and 5 are items invalid, there are item number 

5, 11, 15, 27, 28. 

2. From 40 items of vocabulary mastery test, 31 items are valid 

and 9 items are invalid there are item number 5, 12, 13, 17, 

21, 27, 29, 32, 40. 

3. The expert judgment of speaking test is consulted to the 

Zainal Arifin, S.Pd., M.Pd as the advisor and Siti Aminah, 

S.Pd as the English teacher. 

 

b. Reliability of the Instrument 

Arikunto (2006:178) says that reliability refers to the 

understanding that a sufficiently reliable instrument to be used as a 

means of collecting data because the instrument is good. Sugiyono 

(2010:173) states that reliability is an instrument when used several 

time to measure the same object, the result of data will consistency 

or stability.  
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To measure the reliability of extroversion personality 

questionnaire and the reliability of the vocabulary mastery test, the 

researcher used the Alpha Cronbach formula assisted by SPSS 20 

program for windows to compute the reliability test, and the result 

are as follows: 

1) Reliability of Extroversion Personality 

Table 3.6 The Reliability of Extroversion Personality 

Reliability Statistics 

Cronbach's 

Alpha 

N of Items 

,924 28 

 

From the result of reliability extroversion personality is 

acquired the reliability coefficient = 0.924 in the rtable = 0.312 

at the level of significance 0.05 for the number of students is 

40 students. It shows that the extroversion personality is 

reliable ro > rtable (0.924 > 0.312). 

2) Reliability of Vocabulary Mastery 

Table 3.7 The Reliability of Vocabulary Mastery 

Reliability Statistics 

Cronbach's 

Alpha 

N of Items 

,875 40 

 

From the result of reliability vocabulary mastery is acquired 

the reliability coefficient = 0.875 in the rtable = 0.312 at the 

level of significance 0.05 for the number of students is 40 
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students. It shows that the vocabulary mastery is reliable ro > 

rtable (0.875 > 0.312).  

 

3) Reliability of Speaking Ability 

The reliability of speaking ability test is measured by 

using inter-rater reliability. Inter-rater reliability occurs when 

two or more scores yield inconsistent scores of the same test, 

possibly for lack of attention to scoring criteria, inexperience, 

inattention, or even preconceived biases (Brown, 2004: 21). To 

measure the reliability of speaking ability, the researcher 

compared the speaking test score with the score from the 

teacher. The score of speaking test can be seen in appendix 17. 

 

E. The Technique of Analyzing Data 

After collecting the data, the next step is analyzing the data in order 

to know whether there is a significant positive correlation between 

students extroversion personality and vocabulary mastery toward their 

speaking ability. Firstly, the researcher check the completeness of the data 

then give scoring toward the questionnaire, vocabulary test and speaking 

ability test. Next, the researcher process the data, as follow: 

1. The Description of the Data 

a. Mean 

Mean is the average value of the data group.  
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b. Median 

Median is the central value of data group. It is gained by 

picking the middle value of the data ranged from the lowest to the 

highest or inversely (Arikunto, 2006:168). 

c. Mode 

Mode is the most frequent value of a data group. It is gained 

by counting the similar data and finding the highest. (Arikunto, 

2006:166). 

d. Range  

Range is the gap between the highest and the lowest value in 

a data group (Arikunto, 2006:152).  

e. Standard Deviation 

The standard deviation is a numerical index that indicates the 

average variability of the scores. It tells us, in other words, about 

distance, on the average of the score from the mean (McMillan and 

Schumacher, 2001:221). 

The researcher uses program SPSS 20 to analyze the data 

description, how to obtain the result is available in appendix 18. 

 

2. Prerequisite Test 

a. Normality Test 

Normality test is purposed to know whether the sample taken 

from the population has normal distribution or not (Arikunto, 

2006:320). In this study, the researcher uses the Kolmogorov Smirnov 
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(KS-Z) formula through SPSS 20 for windows with the significant 5%, 

how to obtain the result of normality testing is available in appendix 

18. The characteristic used is whether the obtained of KS-Z is higher 

than 0.05, it means that the data has a normal distribution.  

b. Linearity Test 

Linearity test was aimed to know whether two variables had 

significant linear regression or not  (Abdurrahman, et al, 2011:214). 

To find out the simple linier regression between the first 

independent variable (extroversion personality) and the dependent 

variable (speaking ability) and the second independent variable 

(vocabulary mastery) and the dependent variable (speaking ability), 

the researcher uses F test with the significant 0.05 with SPSS 20 for 

windows, how to obtain the result of linearity is available in appendix 

18. The criteria of this test is if the value of linearity is lower than 

0.05.    

3. Hypothesis Testing 

After conducting the prerequisite test, the next step was testing 

hypothesis. 

a. The Test of the First and Second Hypothesis 

The test of the first and second hypothesis are used to know the 

correlation between extroversion personality (X1) and the speaking 

ability (Y) and the correlation between vocabulary mastery (X2) and 

speaking ability (Y).  
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The researcher used simple correlation technique using the 

Product Moment Formula assisted by SPSS 20 for windows to test the 

first and the second hypothesis, how to obtain the result is available in 

appendix 18. The formula of simple correlation is as follow: 

     
 ∑    ∑   ∑  

√   ∑    (∑   }    ∑     ∑    

 

 

Where: 

Rxy : the coefficient of the correlation between variable X and Y 

X : the independent variable 

Y : the dependent variable 

n : the number of the sample 

The statistical hypothesis of the first and second hypothesis: 

a) Ho : rxy = 0. It means there is no correlation between X and Y. 

b) Ha : rxy > 0. It means there is a positive correlation between X 

and Y. 

b. The Test of the Third Hypothesis 

The test of the third hypothesis is used to know the 

correlation between extroversion personality, vocabulary mastery, 

and speaking ability. The researcher used multiple correlation 

assisted by SPSS 20 for windows to test the third hypothesis saying 

there is any correlation between students extroversion personality, 

vocabulary mastery and speaking ability, how to obtain the result is 

available in appendix 18. The formula is as follows: 
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          √
                         

          
 

c. The significance of the multiple correlation Coefficient 

The researcher used the formula of regression line analysis to 

find out whether or not the coefficient of multiple correlation is 

significant as follows: 

   
     

              
 

Where: 

F : the value of regression line 

R : the coefficient of correlation between X1, X2, and Y 

k : number of independent variable 

n : the number of sample 

(Sudjana, 1996:385) 

d. Cotribution Distribution 

After that, the researcher uses coefficient of determination to 

calculate the distribution of variable X toward variable Y. the 

formula as follows: 

                 

CD : the coefficient of determination 

r : the coefficient of correlation 

 



CHAPTER IV 

RESEARCH FINDING AND DISCUSSION 

 

 

A. Research Finding 

1. The Description of the Data 

The data analyzed were the result of questionnaire and test. The 

researcher description were based on the score of questionnaire to know 

the extroversion personality, the vocabulary test to know the students’ 

vocabulary mastery, and the speaking test to know the speaking ability 

among the eleventh grade students of MAN 1 Semarang in the academic 

year 2017/2018. In computing the data, the researcher is assisted by SPSS 

20 for windows to analyze all data and hypothesis. It is presented in the 

form of mean, median, mode, standard deviation, the highest and lowest 

score which is completed with the variable description in the form of table 

and histograms. The score of extroversion personality, vocabulary 

mastery test, and speaking ability can be seen in the table 4.1. 

Table 4.1 Students’ Score of each Variable 

 

No Name 

Score 

Extroversion 

personality 

Vocabulary 

Mastery 

Speaking 

ability 

1 AF 52 77 84 

2 ANC 80 90 84 

3 ASF 79 84 74 

4 AI 80 90 82 

5 AAAR 73 90 84 

6 EPL 60 77 74 

7 F 67 77 60 

8 FAA 64 74 66 

9 FFS 56 65 66 

10 FIM 79 77 74 
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No Name 

Score 

Extroversion 

personality 

Vocabulary 

Mastery 

Speaking 

Ability 

11 HM 64 90 72 

12 KF 68 74 84 

13 LT 76 94 82 

14 LFM 66 90 74 

15 MK 66 87 74 

16 MA 52 77 52 

17 MMH 64 81 80 

18 MM 56 87 74 

19 ML 74 84 76 

20 NN 73 81 78 

21 RAM 73 81 70 

22 SQ 80 84 74 

23 SSH 58 77 62 

24 SMS 74 81 70 

25 TW 64 84 78 

26 UI 83 81 94 

27 UNN 67 87 76 

28 AAS 58 84 78 

29 AM 66 81 78 

30 AR 80 74 54 

31 A 72 68 56 

32 AN 79 68 60 

33 ECK 87 90 90 

34 FDS 52 77 50 

35 FIC 73 74 64 

36 HIL 73 74 62 

37 IR 60 77 64 

38 LK 52 71 60 

39 LDA 56 65 60 

40 MLF  56 77 60 

41 MF 83 71 72 

42 MAM 59 68 56 

43 MRA 59 71 52 

44 M 78 90 86 

45 MA 59 65 70 

46 MAF 56 71 60 

47 MF 67 74 64 

48 MS 87 87 80 

49 MTK 68 74 71 

50 NT 60 81 72 

51 SK 80 71 56 

52 SNK 64 74 66 

53 SSW 74 77 72 
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No Name 

Score 

Extroversion 

Personality 

Vocabulary 

Mastery 

Speaking 

Ability 

54 TS 67 71 64 

55 SUH 52 68 58 

56 TS 67 71 64 

57 UNL 64 68 60 

58 ZN 76 68 72 

 

The data research from three variables is summarized below: 

 

Table 4.2 Variable Data Description 

 

 

 

 

 

 

 

 

 

The data obtained, namely: extroversion personality, vocabulary 

mastery, and speaking ability can be explained as follows: 

a) The Data of Extroversion Personality 

 The data of extroversion personality were collected by using a 

questionnaire. The maximum score of the test is 87, the minimum 

score is 52, and the range is 35. The mean (or the average score) and 

standard deviation are 68.02 and 9.93 respectively. The frequency 

Statistics 

 Extroversion Vocabulary Speaking 

N 
Valid 58 58 58 

Missing 0 0 0 

Mean 68,02 77,91 69,83 

Median 67,00 77,42 71,50 

Mode 64
a
 77 60

a
 

Std. Deviation 9,932 7,887 10,298 

Variance 98,649 62,212 106,040 

Range 35 29 44 

Minimum 52 65 50 

Maximum 87 94 94 

Sum 3945 4519 4050 
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distribution and the histogram of extroversion personality can be seen 

at the table 4.3 and the figure 4.1 

Table 4.3 The Frequency Data of Extroversion Personality 

Extroversion 

 Frequen
cy 

Percent Valid 
Percent 

Cumulative 
Percent 

Valid 

52 5 8,6 8,6 8,6 

56 5 8,6 8,6 17,2 

58 2 3,4 3,4 20,7 

59 3 5,2 5,2 25,9 

60 3 5,2 5,2 31,0 

64 6 10,3 10,3 41,4 

66 3 5,2 5,2 46,6 

67 4 6,9 6,9 53,4 

68 2 3,4 3,4 56,9 

72 1 1,7 1,7 58,6 

73 5 8,6 8,6 67,2 

74 3 5,2 5,2 72,4 

76 2 3,4 3,4 75,9 

78 1 1,7 1,7 77,6 

79 3 5,2 5,2 82,8 

80 6 10,3 10,3 93,1 

83 2 3,4 3,4 96,6 

87 2 3,4 3,4 100,0 

Total 58 100,0 100,0  

 

 
Figure 4.1 the histogram of Extroversion Personality 
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b) The Data of Vocabulary Mastery 

The data of vocabulary mastery were collected by using a multiple 

choice test. The maximum score of the test is 94, the minimum score 

is 65, and the range is 29. The mean (or the average score) and 

standard deviation are 77.42 and 7.88 respectively. The frequency 

distribution and the histogram of extroversion personality can be seen 

at the table 4.4 and the figure 4.2. 

 
Table 4.4 The Frequency Data of the Score of Vocabulary Mastery 

Vocabulary 

 Frequency Percent Valid Percent Cumulative 
Percent 

Valid 

65 2 3,4 3,4 3,4 

65 1 1,7 1,7 5,2 

68 7 12,1 12,1 17,2 

71 6 10,3 10,3 27,6 

74 2 3,4 3,4 31,0 

74 6 10,3 10,3 41,4 

77 2 3,4 3,4 44,8 

77 8 13,8 13,8 58,6 

81 7 12,1 12,1 70,7 

84 5 8,6 8,6 79,3 

87 4 6,9 6,9 86,2 

90 7 12,1 12,1 98,3 

94 1 1,7 1,7 100,0 

Total 58 100,0 100,0  

 

 
 

Figure 4.2 The Frequency Histogram of the Score of Vocabulary Mastery 
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c) The Data of Speaking Ability 

The data of speaking ability were collected by using a oral test. 

The maximum score of the test is 94, the minimum score is 50, and 

the range is 35. The mean (or the average score) and standard 

deviation are 69.83 and 10.29 respectively. The frequency distribution 

and the histogram of extroversion personality can be seen at the table 

4.5 and the figure 4.3. 

 

Table 4.5 The Frequency Data of Score of Speaking Ability 

Speaking 

 Frequency Percent Valid Percent Cumulative 
Percent 

Valid 

50 1 1,7 1,7 1,7 

52 2 3,4 3,4 5,2 

54 1 1,7 1,7 6,9 

56 3 5,2 5,2 12,1 

58 1 1,7 1,7 13,8 

60 7 12,1 12,1 25,9 

62 2 3,4 3,4 29,3 

64 4 6,9 6,9 36,2 

65 1 1,7 1,7 37,9 

66 3 5,2 5,2 43,1 

70 3 5,2 5,2 48,3 

71 1 1,7 1,7 50,0 

72 5 8,6 8,6 58,6 

74 7 12,1 12,1 70,7 

76 2 3,4 3,4 74,1 

78 4 6,9 6,9 81,0 

80 2 3,4 3,4 84,5 

82 2 3,4 3,4 87,9 

84 4 6,9 6,9 94,8 

86 1 1,7 1,7 96,6 

90 1 1,7 1,7 98,3 

94 1 1,7 1,7 100,0 

Total 58 100,0 100,0  
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Figure 4.3 the frequency histogram of the score of speaking ability 

 

 

2. Pre-Requisite Test 

a. Normality Testing 

Normality testing distribution is purposed to know whether the 

variable data research distribution is normal or not. There are three 

variable of normality testing in this research, normality of extroversion 

personality, normality of vocabulary mastery, and normality of 

speaking ability. To test the normality distribution of data, the 

researcher uses Kolmogorov-Smirnov by SPSS 20 for windows. The 

result can be seen at the table 4.6 below. 

 

Table 4.6 The Normality Testing 

Tests of Normality 

 Kolmogorov-Smirnov
a
 Shapiro-Wilk 

Statistic df Sig. Statistic df Sig. 

Extroversion ,106 58 ,164 ,954 58 ,027 

Vocabulary ,111 58 ,073 ,954 58 ,026 

Speaking ,089 58 ,200
*
 ,979 58 ,430 
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From the table above, it can be interpreted as follows: 

1) Normality testing of Extroversion personality 

After being computed, the value for N = 58 at the level of 

significant α = 0.05 is 0.164. Because the value is higher than 0.05 

or 0.164 > 0.05, so the distribution of data extroversion personality 

is normal. 

2) Normality testing of vocabulary mastery 

After being computed, the value for N = 58 at the level of 

significant α = 0.05 is 0.073. Because the value is higher than 0.05 

or 0.073 > 0.05, so the distribution of data vocabulary mastery is 

normal. 

3) Normality testing of speaking ability 

After being computed, the value for N = 58 at the level of 

significant α = 0.05 is 0.200. Because the value is higher than 0.05 

or 0.200 > 0.05, so the distribution of data speaking ability is 

normal. 

 

b. Linearity Testing 

Linearity test was aimed to know whether two variables had 

significant linear regression or not  (Abdurrahman, et al, 2011:214). 

Here the description of linearity testing: 
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1) Linearity Testing of Extroversion Personality (X1) and Speaking 

Ability (Y) 

Table 4.7 Data of Linearity Testing of Extroversion Personality and Speaking 

Ability 

 

The linearity testing from extroversion personality and 

speaking ability that the value F-obtained of the Fdeviation is 1.035. 

The value significant of linearity is 0.001, because the significant is 

lower than 0.05 or 0.001 < 0.05, so the regression between 

extroversion personality and speaking ability is linear. 

2) Linearity Testing of Vocabulary Mastery (X2) and Speaking Ability 

(Y) 

Table 4.8 Data of Linearity Testing of Vocabulary Mastery and Speaking 

Ability 

 

 

From the data above, the linearity testing from vocabulary 

mastery and speaking ability that the value F-obtained of the 

Fdeviation is 1.562. The value significant of linearity is 0.000, 
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because the significant is lower than 0.05 or 0.000 < 0.05, so the 

regression between vocabulary mastery and speaking ability is 

linear.  

 

3. The Hypothesis Testing 

Since the computation of normality and linearity testing shows that the 

data are in normal distribution and the regression is linear, the researcher 

continue to test the three hypothesis of the research stated on the previous 

chapter. To test hypothesis, the researcher uses SPSS 20 for windows to 

analyze the data. How to obtain the result is available in appendix 18. 

Further explanation on correlation of instruments are presented at the 

Table 4.9 as follows: 

Table 4.9 Correlations of the Variable 

Correlations 

 Extroversion Vocabulary Speaking 

Extroversion 

Pearson Correlation 1 ,311
*
 ,436

**
 

Sig. (2-tailed)  ,018 ,001 

N 58 58 58 

Vocabulary 

Pearson Correlation ,311
*
 1 ,667

**
 

Sig. (2-tailed) ,018  ,002 

N 58 58 58 

Speaking 

Pearson Correlation ,436
**
 ,667

**
 1 

Sig. (2-tailed) ,001 ,002  

N 58 58 58 

 

 

From the table above, it can be interpreted as follows: 

a. First Hypotheses 

The first hypothesis says that there is a positive correlation 

between extroversion personality (X1) and speaking ability (Y). 
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That hypothesis is alternative hypothesis (Ha). To test the 

hypothesis, Ha is changed become null hypothesis (Ho), it says that 

there is no positive correlation between extroversion personality 

(X1) and speaking ability (Y).  

The statistical hypothesis of the first hypothesis: 

1) Ho : rxy = 0. It means there is no correlation between X1 and Y 

2) Ha : rxy > 0. It means there is a positive correlation between X1 

and Y. 

The result of the computation shows that the coefficient of 

correlation (r) between extroversion personality (X1) and speaking 

ability (Y) is 0.436 with significantly (p) = 0.001. It means that 

there is significant correlation between extroversion personality 

and speaking ability because ρ < α (0.001 < 0.05). Thereby, Ho is 

rejected and Ha is accepted so it can be conclude that there is a 

correlation between extroversion personality. 

From the explanation above, it also can be known that the 

coefficient determination between extroversion personality (X1) 

and speaking ability (Y) is 0.436. The contribution of extroversion 

personality (X1) and speaking ability (Y) is that CD = r
2
 x 100% = 

(0.436)
2
 x 100% = 19%. It means that 19% variance of speaking 

ability is influenced by the extroversion personality, while 81% is 

contributed by other factors. 
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b. Second Hypothesis 

The second hypothesis says that there is a positive correlation 

between vocabulary mastery (X2) and speaking ability (Y). That 

hypothesis is alternative hypothesis (Ha). To test the hypothesis, 

Ha is changed become null hypothesis (Ho), it says that there is no 

positive correlation between vocabulary mastery (X2) and speaking 

ability (Y).  

The statistical hypothesis of the first hypothesis: 

1) Ho : rxy = 0. It means there is no correlation between X2 and Y 

2) Ha : rxy > 0. It means there is a positive correlation between X2 

and Y. 

The result of the computation shows that the coefficient of 

correlation (r) between vocabulary mastery (X2) and speaking 

ability (Y) is 0.667 with significantly (ρ) = 0.002. It means that 

there is significant correlation between vocabulary mastery and 

speaking ability because ρ < α (0.002 < 0.05). 

From the explanation above, it also can be known that the 

coefficient determination between vocabulary mastery (X2) and 

speaking ability (Y) is 0.667. The contribution of vocabulary 

mastery (X2) and speaking ability (Y) is that CD = r
2
 x 100% = 

(0.667)
2
 x 100% = 44.5%. It means that 44.5% variance of 

speaking ability is influenced by students’ vocabulary mastery, 

while 55.5% is contributed by other factors. 
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c. The Third Hypothesis 

The third hypothesis says that there is a positive correlation 

between extroversion personality (X1), vocabulary mastery (X2), 

and speaking ability (Y). To test the hypothesis, the researcher uses 

the Multiple Linear Regression Formula with SPSS 20 for 

windows. How to obtain the result is available in the appendix 18 

and the hypothesis test result can be seen in table 4.10. 

 

  Table 4.10 The Result of the Third Hypothesis 

 

 

The statistical hypothesis of the third hypothesis are: 

1) Ho : rx1x2y = 0. It means there is no correlation between X1, X2, 

and Y 

2) Ha : rx1x2y > 0. It means there is a positive correlation between 

X1, X2, and Y. 

The result of the computation shows that the coefficient of 

correlation (r) between extroversion personality (X1), vocabulary 

mastery (X2) and speaking ability (Y) is 0.709 with significantly 

(ρ) = 0.000. It means that there is significant correlation between 

vocabulary mastery and speaking ability because ρ < α (0.001 < 

0.05). 
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From the explanation above, it also can be known that the 

coefficient determination between extroversion personality (X1), 

vocabulary mastery (X2) and speaking ability (Y) is 0.709. The 

contribution of vocabulary mastery (X2) and speaking ability (Y) is 

that CD = r
2
 x 100% = (0.709)

2
 x 100% = 50.3%. It means that 

50.3% variance of speaking ability is influenced by extroversion 

personality and vocabulary mastery, while 49.7% is contributed by 

other factors. 

 

B. Discussion of the Research Finding 

The discussion of the research finding focuses on the result of hypothesis 

testing. There are three hypothesis testing in this research is as follow: 

1. The first finding of the hypothesis testing shows that there is a positive 

correlation between extroversion personality (X1) and speaking ability 

(Y). Based on the result product moment correlation analysis, the value 

of significance testing also shows that the correlation between 

extroversion personality and speaking ability is significant, because ρ 

< α (0.001 < 0.05). The coefficient of determination between 

extroversion personality and speaking ability is 19%. It means that 

19% speaking ability is influenced by extroversion personality and 

81% is influenced by other factors. From the score, it can be known 

that extroversion personality gives contribution to speaking ability. 

When the students’ extroversion personality increases, so the speaking 

ability will be high. It is supported by Brown (2007:167) explains that 
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extroversion is a potential and very important factor in second 

language acquisition, especially in gaining speaking ability. It means 

there is positive significant correlation between extroversion 

personality and speaking ability among the eleventh grade students of 

MAN 1 Semarang in the academic year 2017/2018, it also means that 

the increase of extroversion personality will be followed by the 

enhancement of speaking ability. 

2. The second finding of the hypothesis testing shows that there is a 

positive correlation between vocabulary mastery (X2) and speaking 

ability (Y). Based on the result product moment correlation analysis, 

the value of significance testing also shows that the correlation 

between vocabulary mastery and speaking ability is significant, 

because ρ < α (0.002 < 0.05). The coefficient of determination between 

vocabulary mastery and speaking ability is 44.5%. It means that 44.5% 

speaking ability is influenced by vocabulary mastery and 55. 5% is 

influenced by other factors. From the score, it can be known that 

vocabulary mastery gives contribution to speaking ability. It is 

supported by McCharty (1990:8) states that no matter how 

successfully sounds of L2 are mastered, without words to express a 

wider range of meanings, communication in an L2 just cannot happen 

in any meaningful way. When the students’ vocabulary mastery 

increases, so the speaking ability will be high. It means there is 

positive significant correlation between vocabulary mastery and 

speaking ability among the eleventh grade students of MAN 1 
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Semarang in the academic year 2017/2018, it also means that the 

increase of vocabulary mastery will be followed by the enhancement 

of speaking ability. 

3. The third finding of the hypothesis testing shows that there is a 

positive correlation between extroversion personality (X1), vocabulary 

mastery (X2), and speaking ability (Y). Based on the result product 

moment correlation analysis, the value of significance testing also 

shows that the correlation between vocabulary mastery and speaking 

ability is significant, because ρ < α (0.001 < 0.05). The coefficient of 

determination between extroversion personality, vocabulary mastery, 

and speaking ability is 50.3%. It means that 50.3% speaking ability is 

influenced by extroversion personality and vocabulary mastery and 

49.7% is influenced by other factors. From the score, it can be known 

that extroversion personality and vocabulary mastery give contribution 

to speaking ability. When the students’ extroversion personality and 

vocabulary mastery increases, so the speaking ability will be high. It 

means there is positive significant correlation between extroversion 

personality, vocabulary mastery and speaking ability among the 

eleventh grade students of MAN 1 Semarang in the academic year 

2017/2018, it also means that the increase of vocabulary mastery will 

be followed by the improvement of speaking ability. 

 



CHAPTER V 

CONCLUSION, IMPLICATION, AND RECOMMENDATION 

 

 

A. Conclusion 

The aim of this study is to know whether there is positive correlation 

between three variables, namely, extroversion personality, vocabulary 

mastery, and speaking ability. Based on the problem statements in previous 

chapter and the result of the study, it can be concluded that: 

1. There is a positive and significant correlation between extroversion 

personality and speaking ability among the eleventh grade students of 

MAN 1 Semarang. It means that the improvement of extroversion 

personality will be followed by the improvement of speaking ability. It 

also means that the extroversion personality has contribution to their 

speaking ability. The relative contribution of extroversion personality to 

speaking ability is 19% while 81% is contributed by other factors. 

2. There is a positive and significant correlation between vocabulary mastery 

and speaking ability among the eleventh grade students of MAN 1 

Semarang. It means that the improvement of vocabulary mastery will be 

followed by the improvement of speaking ability. It also means that the 

extroversion personality has contribution to their speaking ability. The 

relative contribution of extroversion personality to speaking ability is 

44.5% while 55.5% is contributed by other factors. 

3. There is a positive and significant correlation between extroversion 

personality and vocabulary mastery simultaneously toward speaking 
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ability among the eleventh grade students of MAN 1 Semarang. It means 

that the improvement of students’ extroversion personality and students’ 

vocabulary mastery will be followed by the improvement of speaking 

ability. It also means that the extroversion personality has contribution to 

their speaking ability. The relative contribution of extroversion 

personality and to speaking ability is 55.5% while 44.5% is contributed 

by other factors. 

 

B. Implication 

Based on the research finding, it can be conclude that there is a 

positive correlation between extroversion personality, vocabulary mastery 

and speaking ability among the eleventh grade students of MAN 1 

Semarang. A positive correlation means that the increase of students’ 

extroversion personality and vocabulary is followed by increase of 

students’ speaking ability. Based on the research finding and conclusion, it 

was found that extroversion personality and vocabulary mastery have 

contribution in speaking ability. From the result of this study, the 

implication can be taken from this study is that enhancing students’ 

extroversion personality and vocabulary mastery have to be considered to 

enhance their speaking ability. Then, the students necessary to improve 

extroversion personality and should practice the activities which are 

related to vocabulary in their daily live to improve their speaking ability. 

Because with activities learning, the students can improve their speaking 

ability. 
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C. Recommendation 

Based on the conclusion and implication above, the researcher 

gives some suggestion bellow: 

1. For the teachers 

a. Teacher should understand students’ personality types in order to 

get the best ways of learning, teaching method, and ideal classroom 

environment. 

b. Teacher should improve his/her professional skill, especially 

English vocabulary mastery. It can be through formal education 

improvement, upgrading, and training. 

2. For the students 

a. Students should improve their mastery of vocabulary since this 

skill will be very important for them in learning English. 

b. Students should maintain their extroversion personality because 

personality can be done by knowing extrovert types learn best. 

3. For other researchers 

The researcher realize that the result of this research is still far 

from being perfect. Based on the result, the effective contribution of 

extroversion personality and vocabulary mastery toward speaking 

ability is 55.5%, it means there are still many aspects that could 

influence speaking ability. The researcher expects that there will be 

other researchers who investigate other aspects relating to speaking 

ability, but hopefully that this research will be useful as reference to 
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their researches. Besides, it can also be used by them to carry out and 

develop a similar study. 
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APPENDIX 1 List of Students Joining Try Out 

 

List of the Students Joining Try Out 

 

No Name 

1 ANB 

2 AL 

3 AAL 

4 AK 

5 AASB 

6 ASL 

7 AT 

8 DS 

9 DNK 

10 FA 

11 IQM 

12 IA 

13 ILK 

14 JSD 

15 KD 

16 MKA 

17 NSK 

18 N 

19 NA 

20 NK 

No Name 

21 PSA 

22 RSN 

23 SAN 

24 SR 

25 SM 

26 SA 

27 TA 

28 WAF 

29 TAMSA 

30 AML 

31 FA 

32 AR 

33 AS 

34 ZHA 

35 YNS 

36 TU 

37 AFA 

38 VNA 

38 WW 

40 RQR 
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APPENDIX 2 List of Sample 

 

List of Sample 

No Name 

1 AF 

2 ANC 

3 ASF 

4 AI 

5 AAAR 

6 EPL 

7 F 

8 FAA 

9 FFS 

10 FIM 

11 HM 

12 KF 

13 LT 

14 LFM 

15 MK 

16 MA 

17 MMH 

18 MM 

19 ML 

20 NN 

21 RAM 

22 SQ 

23 SSH 

24 SMS 

25 TW 

26 UI 

27 UNN 

28 AAS 

29 AM 

30 AR 

No Name 

31 A 

32 AN 

33 ECK 

34 FDS 

35 FIC 

36 HIL 

37 IR 

38 HM 

39 LK 

40 LDA 

41 MLF  

42 MF 

43 MAM 

44 MRA 

45 M 

46 MA 

47 MAF 

48 MF 

49 MS 

50 MTK 

51 NT 

52 SK 

53 SNK 

54 SSW 

55 SUH 

56 TS 

57 UNL 

58 ZN 
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APPENDIX 3 Speaking Test 

 

Choose the one of food or drink below, then explain how to make it orally in front of 

class! 

1. Fried rice 

2. A cup of coffee 

Your performance is scored based on pronunciation, vocabulary, grammar, fluency, 

and comprehension. 
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APPENDIX 4 The Blueprint of the Questionnaire (Try Out) 

 

The Blueprint of Extroversion Personality (Try Out) 

Operational 

definition 
Aspects 

Number of the test 
Total % 

Positive Negative 

Extroversion is 

one’s 

personality 

with which he 

enjoys getting 

together with 

others, loves 

meeting people 

and feels 

confident in 

attending 

social 

programs. 

(Iskandar, 

2000: 46) 

Activity 1, 3, 5 2, 4, 6 6 21,4 

Sociability 17, 27 18, 28 4 14,3 

Risk-taking 7, 19 8, 20 4 14,3 

Impulsiveness 9, 11 10, 12 4 14,3 

Expressiveness 13 14 2 7,1 

Reflectiveness 23, 25,  24, 26  4 14,3 

Irresponsibility 15, 21 16, 22 4 14,3 

 Total 28 100 
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APPPENDIX 5 The Extroversion Personality Questionnaire (Try Out) 

 

QUESTIONNAIRE OF EXTROVERSION PERSONALITY (TRY OUT) 

Berilah tanda (√) dengan jawaban yang anda pilih! 

Nama : 

Kelas : 

Setiap pernyataan berikut merujuk apa yang Anda rasakan tentang kelas bahasa 

inggris Anda. Silahkan pilih apakan Anda: 

SS : Sangat Setuju    TS : Tidak Setuju 

S : Setuju     STS : Sangat Tidak Setuju 

KS : Kurang Setuju 

No Pernyataan 
Pilih jawaban 

SS S KS TS STS 

1 Saya aktif berbicara bahasa 

Inggris saat pelajaran bahasa 

Inggris 

     

2 Saya tidak aktif berbicara bahasa 

Inggris saat pelajaran bahasa 

Inggris 

     

3 Saya semangat mengikuti 

pelajaran bahasa Inggris, 

terutama materi speaking 

     

4 Saya tidak semangat mengikuti 

pelajaran bahasa Inggris, 

terutama materi speaking 

     

5 Saya melakukan latihan berbicara 

bahasa Inggris dengan suara keras 

     

6 Saya tidak  melakukan latihan 

berbicara bahasa Inggris dengan 

suara keras 

     

7 Saya berani menjawab 

pertanyaan guru dengan bahasa 

Inggris meskipun jawaban saya 

salah 

 

     

8 Saya tidak berani menjawab 

pertanyan guru dengan bahasa 

Inggris karena takut salah 
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No Pernyataan 
Pilih jawaban 

SS S KS TS STS 

9 Saya biasa menjawab pertanyaan 

dengan bahasa Inggris secara 

spontan tanpa berpikir lama. 

     

10 Saya berpikir cukup lama untuk 

menjawab pertanyaan dengan 

bahasa Inggris 

     

11 Saya selalu memikirkan dengan 

pertimbangan untuk sesuatu yang 

saya katakan ketika mengunakan 

bahasa Inggris 

     

12 Saya tidak pernah berfikir terlalu 

lama untuk sesuatu yang saya 

katakan ketika mengunakan 

bahasa ingris 

     

13 Saya dapat mengekspresikan apa 

yang saya ungkapkan dalam 

praktik speaking 

     

14 Saya tidak dapat 

mengekspresikan apa yang saya 

ungkapkan dalam praktik 

speaking 

     

15 Saya percaya diri saat berbicara 

dengan bahasa Inggris 

     

16 Saya tidak percaya diri saat 

berbicara menggunakan bahasa 

Inggris 

     

17 Saya tidak merasa malu berbicara 

menggunakan bahasa Inggris 

kepada orang yang baru saya 

kenal  

     

18 Saya merasa malu berbicara 

menggunakan bahasa Inggris 

kepada orang yang baru saya 

kenal 

     

19 Saya berani mengambil resiko 

untuk terus berbicara dalam 

bahasa Inggris 

     

20 Saya tidak berani mengambil 

resiko untuk terus berbicara 

bahasa Inggris 

     

21 Saya tidak peduli orang lain 

menertawakan saya jika saya 

melakukan kesalahan ketika 

berbicara bahasa Inggris 
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No Pernyataan 
Pilih jawaban 

SS S KS TS STS 

22 Saya takut orang lain akan 

menertawakan saya jika saya 

melakukan kesalahan ketika 

berbicara bahasa Inggris 

     

23 Saya mencoba berbicara bahasa 

Inggris ketika mendengar 

kosakata baru 

     

24 Saya tidak mencoba berbicara 

bahasa iggris ketika mendengar 

kosakata baru 

     

25 Saya mengungkapkan suatu kata 

dengan cara lain (gerakan tubuh) 

apabila orang lain yang saya ajak 

bicara tidak paham maksud saya 

ketika saya berbicara 

menggunakan bahasa Inggris 

     

26 Saya tetap mengungkapkan 

maksud saya menggunakan 

bahasa Inggris sampai orang lain 

paham 

     

27 Saya mencari topic agar bisa 

berbicara bahasa Inggris dengan 

teman 

     

28 Saya menunggu teman mengajak 

saya berbicara 
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APPENDIX 6 The Blueprint of Extroversion Personality 

 

The Blueprint of Extroversion Personality  

Operational 

definition 
Aspects 

Number of the test 
Total % 

Positive Negative 

Extroversion is 

one’s 

personality 

with which he 

enjoys getting 

together with 

others, loves 

meeting people 

and feels 

confident in 

attending 

social 

programs. 

(Iskandar, 

2000: 46) 

Activity 1, 3 2, 4, 6 5 21,7 

Sociability 17 18 2 8,7 

Risk-taking 7, 19 8, 20 4 17,4 

Impulsiveness 9 10, 12 3 13,05 

Expressiveness 13 14 2 8,7 

Reflectiveness 23, 25,  24, 26  4 17,4 

Irresponsibility 21 16, 22 3 13,05 

 Total 23 100 
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APPENDIX 7 Questionnaire of Extroversion Personality 

 

QUESTIONNAIRE OF EXTROVERSION PERSONALITY  

Berilah tanda (√) dengan jawaban yang anda pilih! 

Nama : 

Kelas : 

Setiap pernyataan berikut merujuk apa yang Anda rasakan tentang kelas bahasa 

Inggris Anda. Silahkan pilih apakan Anda: 

SS : Sangat Setuju    TS : Tidak Setuju 

S : Setuju     STS : Sangat Tidak Setuju 

KS : Kurang Setuju 

 

No Pernyataan 
Pilih jawaban 

SS S KS TS STS 

1 Saya aktif berbicara bahasa 

inggris saat pelajaran bahasa 

inggris 

     

2 Saya tidak aktif berbicara bahasa 

inggris saat pelajaran bahasa 

inggris 

     

3 Saya semangat mengikuti 

pelajaran bahasa inggris, terutama 

materi speaking 

     

4 Saya tidak semangat mengikuti 

pelajaran bahasa inggris, terutama 

materi speaking 

     

5 Saya tidak  melakukan latihan 

berbicara bahasa inggris dengan 

suara keras 

     

6 Saya berani menjawab 

pertanyaan guru dengan bahasa 

inggris meskipun jawaban saya 

salah 

 

     

7 Saya tidak berani menjawab 

pertanyan guru dengan bahasa 

inggris karena takut salah 
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No Pernyataan 
Pilih jawaban 

SS S KS TS STS 

8 Saya biasa menjawab pertanyaan 

dengan bahasa inggris secara 

spontan tanpa berpikir lama. 

     

9 Saya berpikir cukup lama untuk 

menjawab pertanyaan dengan 

bahasa inggris 

     

10 Saya tidak pernah berfikir terlalu 

lama untuk sesuatu yang saya 

katakan ketika mengunakan 

bahasa ingris 

     

11 Saya dapat mengekspresikan apa 

yang saya ungkapkan dalam 

praktik speaking 

     

12 Saya tidak dapat 

mengekspresikan apa yang saya 

ungkapkan dalam praktik 

speaking 

     

13 Saya tidak percaya diri saat 

berbicara menggunakan bahasa 

inggris 

     

14 Saya tidak merasa malu berbicara 

menggunakan bahasa inggris 

kepada orang yang baru saya 

kenal  

     

15 Saya merasa malu berbicara 

menggunakan bahasa inggris 

kepada orang yang baru saya 

kenal 

     

16 Saya berani mengambil resiko 

untuk terus berbicara dalam 

bahasa inggris 

     

17 Saya tidak berani mengambil 

resiko untuk terus berbicara 

bahasa inggris 

     

18 Saya tidak peduli orang lain 

menertawakan saya jika saya 

melakukan kesalahan ketika 

berbicara bahasa Inggris 

     

19 Saya takut orang lain akan 

menertawakan saya jika saya 

melakukan kesalahan ketika 

berbicara bahasa Inggris 

     

20 Saya mencoba berbicara bahasa 

inggris ketika mendengar 

kosakata baru 
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No Pernyataan 
Pilihan Jawaban 

SS S KS TS STS 

21 Saya tidak mencoba berbicara 

bahasa iggris ketika mendengar 

kosakata baru 

     

22 Saya mengungkapkan suatu kata 

dengan cara lain (gerakan tubuh) 

apabila orang lain yang saya ajak 

bicara tidak paham maksud saya 

ketika saya berbicara 

menggunakan bahasa Inggris 

     

23 Saya tetap mengungkapkan 

maksud saya menggunakan 

bahasa Inggris sampai orang lain 

paham 
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APPENDIX 6 The Blueprint of Vocabulary Mastery Try Out 

 

Blueprint of Vocabulary Mastery Try Out 

No Indicator Item’s Number Total 

1 Aspect of Meaning 

- Synonym 

- Antonym 

1, 7, 13, 15, 17, 21, 25, 

31, 37 

9 

2, 6, 9, 10, 20, 24, 26, 36, 

38 

9 

2 Collocation 3, 5, 8, 12, 16, 28, 29, 32  8 

3 Grammar 4, 11, 18, 22, 30, 33 6 

4 Word formation 14, 19, 23, 27, 34, 40 6 

5 Spelling 35, 39  2 

 Total 40 
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APPENDIX 7 Try Out of Vocabulary Mastery  

 

TRY OUT VOCABULARY MASTERY TEST 

Choose the correct answer by crossing (X) a, b, c, d, or e on the answer sheet provided! 

(50 minutes)

1. “Farmer in fertile areas grow rice 

well”. Another word for fertile 

is…. 

a. Rural   d. Remote 

b. Agricultural  e. Productive 

c. Large 

2. One of the goals of the agricultural 

development is to obtain sufficient 

rice production. The opposite of 

word “to obtain” is…. 

a. Get    d. Lose 

b. Win     e. Earn 

c. Attain 

3. They are … the art. 

a. Interest 

b. Interested in 

c. Interesting 

d. Interesting in 

e. Interesting for 

4. Isn’t Dimas the…? 

a. Tall   d. Most Tall 

b. Tallest  e. High 

c. Taller 

5.  “I cannot come to your house 

because it is … rain” 

a. Heavy   d. Large 

b. Big   e. Huge 

c. Great 

6.  “These can be extremely 

dangerous if they are not properly 

used.”. what the antonym of the 

word dangerous? 

a. Safe  d. Ineffective 

b. Useless  e. Complicated 

c. Easeful 

7. Horn-carving is a popular 

handicraft in Pucang, synonym of 

popular is…. 

a. Important   d. Famous 

b. Guess   e. Actors 

c. Produce 

8. My brother ….. the bus go to 

school. 

a. Rides   d. Climb 

b. Drives   e. Go to 

c. Takes 

9. The bedroom is very dirty, but the 

kitchen is …., the antonym of dirty 

is…. 

a. Bad   d. Big 

b. Clean   e. Beautiful 

c. Wet 

10. The opposite of healthy is…. 

a. Friendly   d. Kind 

b. Energetic   e. Sick 

c. Well-known 

11. I have ………. a beautiful rose for 

her. 

a. Brought   d. Brings 

b. Bring   e. Buy 

c. Bringing 

12. I got her number yesterday, so that 

we can….. 

a. Keep relation 

b. Keep communicate 

c. Keep talking 

d. Keep contact 

e. Keep in touch 
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13. Olympics games occur every four 

years. The word occur has the 

meaning as…. 

a. Take place  d. Open 

b. Take after   e. Begin 

c. Take over 

14. Rina : “Do you think we still 

have time to correct our paper?” 

Arfan ; “Well, the lecturer will 

come on an hour. You still have 

time.” 

From the dialogue we can conclude 

that Arfan expresses….. 

a. Unwillingness  d. Possibility 

b. Disagreement  e. Dislikes 

c. Impossibility 

15. Those are drugs for headache. The 

synonym of word “drugs” is…. 

a. Injections          d. Medicines 

b. Pills           e. Capsule 

c. Tablets 

16. Clinic is a place where a doctor 

gives…. 

a. Health check 

b. Medical treatment 

c. Health treatment 

d. Medical examination 

e. Health inspection 

17. The Dimas’ family went to the 

beach for recreation in the last 

holiday. The synonym of the bold 

typed word is a/an…. 

a. Day off   d. Duty 

b. Picnic   e. Holiday 

c. Overtime work 

18. I have lived here….. you were 

child. 

a. Because   d. So 

b. Since   e. Form 

c. Until 

19. Studying hard is the …… of every 

student in order to compete with 

others 

a. Responsibility  d. Response 

b. Responsible  e. Respond 

c. Responding 

20. I have lived in this village since 

two years ago. Antonym for village 

is…. 

a. Country  d. Earth 

b. Field  e. Street 

c. Town 

21. If people use mobile phones, they 

can communicate to others. The 

bold typed word has same meaning 

with….. 

a. Touch   d. Break 

b. Connect   e. Separate 

c. Leave 

22. My mother is one of English 

teacher in this school. She ….. 

here. 

a. Teach   d. Teaching 

b. Teaches   e. Taught 

c. Is teaching 

23. We should not believe everything 

we read or hear because there are 

false predictions and we have to 

be…. 

a. Care   d. Carefully 

b. Careless   e. Carelessly 

c. Careful 

24. The opposite of wet is…. 

a. Cold   d. Dry 

b. Humid   e. Hot 

c. Fry 

25.  “……. is the example of report 

text. It classifies or describes 

something”. The synonym of 

describes is….. 

a. Example   d. Statement 

b. Explain   e. Make 

c. Function 

26.  “Local governments look after the 

small things. The opposite of the 

bold typed word is…… 

a. Little   d. Big 

b. Nice   e. Soft 
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c. Middle 

27. Would you mind ……. until I 

finish typing this letter? 

a. To wait   d. Waiting 

b. To be waiting  e. wait 

c. Will wait 

28. I used to …….. homework with my 

sister’s help. 

a. Make   d. Work 

b. Do    e. Finish 

c. Create 

29. Cintia always ….. to the teachers 

explanation, that’s why she is the 

smartest one in the class. 

a. Hear  d. Pay attention 

b. Give interest  e. Pay notice 

c. Give attention 

30. I always bring my dictionary 

everyday to my school, but I …… 

to bring it yesterday. 

a. Forget   d. Forgetting 

b. Forgot   e. To forget 

c. Forgotten 

31.  “……… computer at school are 

harmless”. The synonym of the 

bold typed word is …. 

a. Unlikely to annoy 

b. Create destruction 

c. Great effort 

d. Household equipment 

e. To make something become 

hard 

32. I am so tired. I need to ……. for a 

while. 

a. Break   d. Rest 

b. Get a break  e. Get a rest 

c. Take a rest 

33. I ……. The Sudirman street when 

it began to rain. 

a. Am waling down 

b. Have walked down 

c. Was walking down 

d. Have been walking down 

e. Would walk down 

34. X : “when did you watch TV last 

night?: 

Y : “well, I watched TV after …… 

my school assignment.” 

a. Finishing         d. I finishing 

b. Finish               e. Have finished 

c. Had finished 

35. The following spellings of these 

word are correct, except …. 

a. Discourage  d. Misplace 

b. Disconnect  e. Missimilar 

c. Misunderstand 

36. Arina has a curly hair, but Anita 

has a …… hair. The opposite of 

curly is …. 

a. Wave   d. Short 

b. Long   e. Straight 

c. Tall 

37. The world’s population will 

increase rapidly. The word rapidly 

has the same meaning as ….. 

a. Quickly   d. Softly 

b. Slowly   e. Quietly 

c. Continually 

38. Einstein is so clever as a scientist at 

long time ago. The opposite of the 

word clever is …. 

a. Wise   d. Silly 

b. Smart   e. Silent 

c. Brilliant 

39. The following spellings are correct, 

except …. 

a. Guilty   d. Catalog 

b. Tongue   e. Fatigue 

c. Dialogue 

40. By ….. English program on radio, 

we can improve our listening 

ability. 

a. Listening to 

b. We are listening to 

c. We listen to 

d. Listened to 

e. We listened to 
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APPENDIX 8 Answer Sheet 

 

 

 

 

ANSWER SHEET  

 

Name : 

 

Class : 

 

1. A B C D E 

2. A B C D E 

3. A B C D E 

4. A B C D E 

5. A B C D E 

6. A B C D E 

7. A B C D E 

8. A B C D E 

9. A B C D E 

10. A B C D E 

11. A B C D E 

12. A B C D E 

13. A B C D E 

14. A B C D E 

15. A B C D E 

16. A B C D E 

17. A B C D E 

18. A B C D E 

19. A B C D E 

20. A B C D E 

21. A B C D E 

22. A B C D E 

23. A B C D E 

24. A B C D E 

25. A B C D E 

26. A B C D E 

27. A B C D E 

28. A B C D E 

29. A B C D E 

30. A B C D E 

31. A B C D E 

32. A B C D E 

33. A B C D E 

34. A B C D E 

35. A B C D E 

36. A B C D E 

37. A B C D E 

38. A B C D E 

39. A B C D E 

40. A B C D E 
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APPENDIX 9 Key answer of Vocabulary Mastery (Try Out) 

 

 

KEY ANSWER OF VOCABULARY (TRY OUT) 

 

1. E 

2. D 

3. B 

4. B 

5. A 

6. A 

7. D 

8. C 

9. B 

10. E 

11. A 

12. B 

13. A 

14. D 

15. D 

16. B 

17. B 

18. B 

19. A 

20. C 

21. B 

22. B 

23. C 

24. D 

25. B 

26. D 

27. D 

28. B 

29. D 

30. B 

31. A 

32. D 

33. C 

34. D 

35. E 

36. E 

37. A 

38. D 

39. D 

40. D 
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APPENDIX 12 The Blue of Vocabulary Mastery Test 

 

Blueprint of Vocabulary Mastery Test 

No Indicator Item’s Number Total 

1 Aspect of Meaning 

- Synonym 

- Antonym 

1, 7, 15, 25, 31, 37 6 

2, 6, 9, 10, 20, 24, 26, 36, 

38 

9 

2 Collocation 3, 8, 16, 28 4 

3 Grammar 4, 11, 18, 22, 30, 33 6 

4 Word formation 14, 19, 23, 34 4 

5 Spelling 35, 39 2 

 Total 31 
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APPENDIX 13 Vocabulary Mastery Test 

 

VOCABULARY MASTERY TEST 

Choose the correct answer by crossing (X) a, b, c, d, or e on the answer sheet provided! 

(50 minutes)

1. “Farmer in fertile areas grow rice 

well”. Another word for fertile 

is…. 

a. Rural   d. Remote 

b. Agricultural  e. Productive 

c. Large 

2. One of the goals of the agricultural 

development is to obtain sufficient 

rice production. The opposite of 

word “to obtain” is…. 

a. Get    d. Lose 

b. Win     e. Earn 

c. Attain 

3. They are … the art. 

a. Interest 

b. Interested in 

c. Interesting 

d. Interesting in 

e. Interesting for 

4. Isn’t Dimas the…? 

a. Tall   d. Most Tall 

b. Tallest  e. High 

c. Taller 

5.  “These can be extremely 

dangerous if they are not properly 

used.”. what the antonym of the 

word dangerous? 

a. Safe  d. Ineffective 

b. Useless  e. Complicated 

c. Easeful 

6. Horn-carving is a popular 

handicraft in Pucang, synonym of 

popular is…. 

a. Important   d. Famous 

b. Guess   e. Actors 

c. Produce 

7. My brother ….. the bus go to 

school. 

a. Rides   d. Climb 

b. Drives   e. Go to 

c. Takes 

8. The bedroom is very dirty, but the 

kitchen is …., the antonym of dirty 

is…. 

a. Bad   d. Big 

b. Clean   e. Beautiful 

c. Wet 

9. The opposite of healthy is…. 

a. Friendly   d. Kind 

b. Energetic   e. Sick 

c. Well-known 

10. I have ………. a beautiful rose for 

her. 

a. Brought   d. Brings 

b. Bring   e. Buy 

c. Bringing 

11. Rina : “Do you think we still 

have time to correct our paper?” 

Arfan ; “Well, the lecturer will 

come on an hour. You still have 

time.” 

From the dialogue we can conclude 

that Arfan expresses….. 

a. Unwillingness  d. Possibility 

b. Disagreement  e. Dislikes 

c. Impossibility 

12. Those are drugs for headache. The 

synonym of word “drugs” is…. 

a. Injections          d. Medicines 

b. Pills           e. Capsule 

c. Tablets 
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13. Clinic is a place where a doctor 

gives…. 

a. Health check 

b. Medical treatment 

c. Health treatment 

d. Medical examination 

e. Health inspection 

14. I have lived here….. you were 

child. 

a. Because   d. So 

b. Since   e. Form 

c. Until 

15. Studying hard is the …… of every 

student in order to compete with 

others 

a. Responsibility  d. Response 

b. Responsible  e. Respond 

c. Responding 

16. I have lived in this village since 

two years ago. Antonym for village 

is…. 

a. Country  d. Earth 

b. Field  e. Street 

c. Town 

17. My mother is one of English 

teacher in this school. She ….. 

here. 

a. Teach   d. Teaching 

b. Teaches   e. Taught 

c. Is teaching 

18. We should not believe everything 

we read or hear because there are 

false predictions and we have to 

be…. 

a. Care   d. Carefully 

b. Careless   e. Carelessly 

c. Careful 

19. The opposite of wet is…. 

a. Cold   d. Dry 

b. Humid   e. Hot 

c. Fry 

20.  “……. is the example of report 

text. It classifies or describes 

something”. The synonym of 

describes is….. 

a. Example   d. Statement 

b. Explain   e. Make 

c. Function 

21.  “Local governments look after the 

small things. The opposite of the 

bold typed word is…… 

a. Little   d. Big 

b. Nice   e. Soft 

c. Middle 

22. I used to …….. homework with my 

sister’s help. 

a. Make   d. Work 

b. Do    e. Finish 

c. Create 

23. I always bring my dictionary 

everyday to my school, but I …… 

to bring it yesterday. 

a. Forget   d. Forgetting 

b. Forgot   e. To forget 

c. Forgotten 

24.  “……… computer at school are 

harmless”. The synonym of the 

bold typed word is …. 

a. Unlikely to annoy 

b. Create destruction 

c. Great effort 

d. Household equipment 

e. To make something become 

hard 

25. I ……. The Sudirman street when 

it began to rain. 

a. Am waling down 

b. Have walked down 

c. Was walking down 

d. Have been walking down 

e. Would walk down 

26. X : “when did you watch TV last 

night?: 

Y : “well, I watched TV after …… 

my school assignment.” 

a. Finishing         d. I finishing 

b. Finish               e. Have finished 



101 
 

c. Had finished 

27. The following spellings of these 

word are correct, except …. 

a. Discourage  d. Misplace 

b. Disconnect  e. Missimilar 

c. Misunderstand 

28. Arina has a curly hair, but Anita 

has a …… hair. The opposite of 

curly is …. 

a. Wave   d. Short 

b. Long   e. Straight 

c. Tall 

29. The world’s population will 

increase rapidly. The word rapidly 

has the same meaning as ….. 

a. Quickly   d. Softly 

b. Slowly   e. Quietly 

c. Continually 

30. Einstein is so clever as a scientist at 

long time ago. The opposite of the 

word clever is …. 

a. Wise   d. Silly 

b. Smart   e. Silent 

c. Brilliant 

31. The following spellings are correct, 

except …. 

a. Guilty   d. Catalog 

b. Tongue   e. Fatigue 

c. Dialogue 
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APPENDIX 14 Key Answer of Vocabulary Test 

 

 

 

KEY ANSWER OF VOCABULARY TEST 

 

1. E 

2. D 

3. B 

4. B 

5. A 

6. D 

7. C 

8. B 

9. E 

10. A 

11. D 

12. D 

13. B 

14. B 

15. A 

16. C 

17. B 

18. C 

19. D 

20. B 

21. D 

22. B 

23. B 

24. A 

25. C 

26. D 

27. E 

28. E 

29. A 

30. D 

31. D 
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APPENDIX 15 The Score of Speaking Test 

 

The  Mean Score of Speaking Done by Rater 1 and Rater 2 

No Name Rater 1 Rater 2 Mean Score 

1 AF 84 84 84 

2 ANC 84 84 84 

3 ASF 76 72 74 

4 AI 84 80 82 

5 AAAR 82 86 84 

6 EPL 68 80 74 

7 F 60 60 60 

8 FAA 68 64 66 

9 FFS 64 68 66 

10 FIM 72 76 74 

11 HM 76 68 72 

12 KF 92 76 84 

13 LT 80 84 82 

14 LFM 68 80 74 

15 MK 68 80 74 

16 MA 48 56 52 

17 MMH 80 70 80 

18 MM 84 64 74 

19 ML 72 80 76 

20 NN 76 64 78 

21 RAM 64 76 70 

22 SQ 84 64 74 

23 SSH 60 64 62 

24 SMS 76 64 70 

25 TS 76 82 78 

26 TW 96 92 94 

27 UI 72 80 76 

28 UNN 76 80 78 

29 AAS 68 56 78 

30 AM 56 52 54 

31 AR 56 56 56 

32 A 52 52 60 

33 AN 88 92 90 

34 ECK 46 52 50 

35 FDS 60 52 64 

36 FIC 60 64 62 

37 HIL 68 60 64 

38 IR 66 52 60 

39 LK 64 58 60 

40 LDA 68 56 60 
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No Name Rater 1 Rater 2 Mean Score 

41 MLF  68 76 72 

42 MF 56 56 56 

43 MAM 52 52 52 

44 MRA 84 88 86 

45 M 64 76 70 

46 MA 52 68 60 

47 MAF 64 64 64 

48 MF 80 80 80 

49 MS 74 68 71 

50 MTK 76 68 72 

51 NT 60 52 56 

52 SK 61 72 65 

53 SNK 60 72 66 

54 SSW 72 72 72 

55 SUH 60 56 58 

56 TS 56 76 64 

57 UNL 58 64 60 

58 ZN 68 62 60 
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Appendix 17 The Results of Vocabulary Mastery 
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APPENDIX 18 The steps of program SPSS 20 for Windows  

 

A. Data Description 

a. Open program SPSS 20 for windows. 

b. Make variable by clicking tab variable view. 

c. Write the name of column in first line X1, second line X2 and third 

line Y. 

d. Change the column of decimals column becomes 0. 

e. Write the label column in first line Extroversion, second line 

Vocabulary, and third line Speaking. As follow: 

 

f. Open data view, input the data in the variable. As follow: 

 

g. Click Analyze > Description Statistic > Frequencies 
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h. Click statistic, then checklist Mean, Median, Mode, Sum, Std. 

deviation, Variance, Range, Minimum, and Maximum. As follow: 

 

i. Click continue > Charts > Checklist Bar Charts > Continue 

 

j. Click Ok 

 

B. Pre-requisite Test 

1. Normality Test 

a. In program SPSS 20 for windows, click Analyze > Descriptive 

Statistics > Explore. As follows: 
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b. Click Extroversion, Vocabulary mastery and Speaking variable into 

dependent list. As follows: 

 

c. Then click Plots checklist Normality plots with tests, as follow: 

 

d. The last, click Continue > OK 

 

2. Linearity Test 

a. In program SPSS 20 for windows, click Analyze > Compare 

Means > Means.  

b. Click Extroversion X1/ Vocabulary X2 variable into Dependent 

list, and Speaking (Y) variable into Dependent list. As follow: 

 



114 
 

c. Click Options > Test for Linearity. As follow: 

 

d. Click Continue > OK. 

 

C. Hypothesis Testing 

1. The first and second hypothesis 

a. In program SPSS 20 for Windows, click Analyze > Correlate > 

Bivariate. 

b. Move on the three variable into variables’ column. As follows: 

 

c. Click Option, choose Means and standard deviation. 

d. Click Continue and OK 

 

2. The third hypothesis 

a. In program SPSS 20 for windows, click Analyze > Regression > 

Linear. As follows: 
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b. Move on “speaking” into Dependent and “extroversion” and 

“vocabulary” into Independent. 

c. Click Statistic. As follows: 

 

d. In Regression Coefficient click Estimates 

e. Then, choose Model fit, R squared change, Part and partial 

correlations, Collinearrity diagnostics. 

f. Click Durbin-Watson in Residual. 

g. Click Continue. 

h. After that, click Pots. As Follow: 

 

i. Click Normal probability plot, and then click Continue and OK. 
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APPENDIX 19 The Validity of the Questionnaire 
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APPENDIX 20 The Validity of Vocabulary Mastery  
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APPENDIX 21 the Documentation 
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APPENDIX 21 Surat Permohonan Izin Penelitian 
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APPENDIX 22 Surat Keterangan Selesai Penelitian 
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